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SCREENBLAST MOVIE STUDIO SOFTWAREii

END-USER LICENSE AGREEMENT
SONY PICTURES DIGITAL INC.

SCREENBLAST MOVIE STUDIO, SCREENBLAST ACID, ACID PRO, SOUND FORGE, SCREENBLAST SOUND FORGE, VEGAS,
VEGAS + DVD, CD ARCHITECT, DVD ARCHITECT, NOISE REDUCTION PLUG-IN, PRESET MANAGER AND SUPER DUPER MUSIC
LOOPER SOFTWARE

THIS IS A LEGAL AGREEMENT ("AGREEMENT") BETWEEN SONY PICTURES DIGITAL INC. ("SONY") AND YOU. YOU AGREE TO BE
BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT IF YOU: (a) INSTALL OR USE ANY PART OF THE SCREEN-
BLAST® MOVIE STUDIO™, SCREENBLAST ACID®, ACID PRO, SOUND FORGE®, SCREENBLAST SOUND FORGE, VEGAS®, VEGAS
+ DVD, CD ARCHITECT™, DVD ARCHITECT™, NOISE REDUCTION PLUG-IN™, PRESET MANAGER AND/OR SUPER DUPER
MUSIC LOOPER™ SOFTWARE (COLLECTIVELY, THE "SOFTWARE") AND RELATED DOCUMENTATION ("SOFTWARE"), OR (b)
CLICK THE ACCEPTANCE BUTTON ON THE ELECTRONIC VERSION OF THIS AGREEMENT. PLEASE READ CAREFULLY. YOUR
USE OF THIS SOFTWARE IS SUBJECT TO THE TERMS OF THIS AGREEMENT AND THE "SOFTWARE PRIVACY POLICY" LINKED
AT THE BOTTOM OF THIS PAGE.

1. GRANT OF LICENSE. Sony hereby grants you a limited, non-exclusive license to use the Software upon the terms and conditions set forth in this
Agreement. Sony reserves all rights not granted in this Agreement.

2. RESTRICTIONS ON USE. You may not: (a) use the Software on more than one computer at a time without purchasing additional licenses, (b) copy
the Software (except for one back-up copy), (c) sublicense, lend, lease or otherwise make the Software available to any third party (on the Internet or
tangible media, by broadcast or in any other manner), (d) modify, adapt, or translate any part of the Software, (e) reverse engineer, decompile or 
disassemble the Software or otherwise attempt to obtain its source code, (f) remove or alter any copyright, trademark or other proprietary notice 
contained in the Software, or (g) use the Software in any manner not set forth in this Agreement or in the Software's documentation.   

3. USE OF CONTENT. You may not use the Software for any purpose that: (a) infringes the copyright, trademark, patent, trade secret, right of publicity
or any other right of a third party, (b) is or may be libelous, defamatory or slanderous, or (c) any other use that is illegal in nature.

4. OWNERSHIP OF SOFTWARE. The Software contains copyrighted material, trademarks and other intellectual property that is provided by and
belongs to third parties ("Third Party Providers"). Sony and the Third Party Providers own and will retain all title, ownership rights and intellectual
property rights in and to the Software.

5. ASSIGNMENT. You may assign the Software to a third party only if they agree to be bound by the terms and conditions of this Agreement. If you
assign the Software, your rights under this Agreement will terminate immediately and you must: (a) cease all use of the Software, (b) permanently
delete all copies of the Software from the computer on which it has been installed, and (c) deliver the original Software to the transferee, You may not
retain the original or any copies of the Software. 

6. TERMINATION. Your right to use the Software will automatically terminate if you fail to comply with any provision of this Agreement. If this
Agreement is terminated you must: (a) cease all use of the Software, (b) destroy the original and all copies of the Software, and (c) permanently delete
all copies of the Software from the computer on which it has been installed.   

7. LIMITED WARRANTY. Sony warrants for a period of 90 days from the date you purchase a license for the Software, that the Software will be free
from material defects in normal use and will perform materially in accordance with its documentation. Sony's entire liability and your sole remedy for a
breach of this warranty is that Sony will, at its option, either: (a) replace the Software or (b) refund the price you paid for the Software.   

8. DISCLAIMER OF WARRANTIES. EXCEPT FOR THE LIMITED WARRANTY PROVIDED ABOVE, THE SOFTWARE IS PROVIDED "AS IS."
SONY AND THE THIRD PARTY PROVIDERS DISCLAIM ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIM-
ITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.
WITHOUT LIMITION OF THE FOREGOING, SONY AND THE THIRD PARTY PROVIDERS DO NOT WARRANT THAT: (a) THE SOFTWARE
WILL BE ERROR-FREE, (b) YOUR USE OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, (c) THE SOFTWARE WILL
MEET YOUR REQUIREMENTS, OR (d) THE SOFTWARE WILL OPERATE WITH THE HARDWARE OR SOFTWARE CONFIGURATION YOU
CHOOSE.

9. LIMITATIONS ON LIABILITY. IN NO EVENT WILL SONY'S, SONY'S AFFILIATES OR THE THIRD PARTY PROVIDERS' LIABILITY TO
YOU OR ANY THIRD PARTY EXCEED THE PRICE PAID BY YOU FOR THE SOFTWARE.
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10. EEXCLUSION OF REMEDIES. WITHOUT LIMITING ANY OF THE DISCLAIMERS OR LIMITATIONS SET FORTH IN PARAGRAPHS 8
AND 9, ABOVE, IN NO EVENT WILL SONY, SONY'S AFFILIATES OR THE THIRD PARTY PROVIDERS BE LIABLE TO YOU OR ANYONE
ELSE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, PUNITIVE OR CONSEQUENTIAL DAMAGES OF ANY KIND ARISING OUT OF YOUR
USE OR INABILITY TO USE THE SOFTWARE (INCLUDING, WITHOUT LIMITATION, LOSS OF PROFITS, DATA OR GOODWILL), EVEN IF
SUCH PARTIES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

11. YOUR SPECIFIC RIGHTS. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF DAMAGES OR LIMITATIONS OF LIABILITY,
SO THE ABOVE EXCLUSIONS OR LIMITATIONS MAY NOT APPLY TO YOU. YOUR SPECIFIC RIGHTS MAY VARY FROM JURISDICTION
TO JURISDICTION.

12. EXPORT RESTRICTIONS. You agree that you will comply with all applicable export laws, restrictions and regulations of the U.S. Department of
Commerce, the U.S. Department of Treasury and any other U.S. or foreign agency or authority. You agree not to export or re-export, or allow the export
or re-export of the Software in violation of any such law, restriction or regulation, including, without limitation, export or re-export to Cuba, Iran, Iraq,
Libya, North Korea, Syria or any other country subject to applicable U.S. trade embargoes, or to any party on the U.S. Export Administration Table of
Denial Orders or the U.S. Department of Treasury List of Specially Designated Nationals and Blocked Persons, or to any prohibited destination in any
of the Country Groups specified in the then current Supplement No. 1 to Part 740 or the Commerce Control List specified in the then current
Supplement No. 1 to Part 738 of the U.S. Export Administration Regulations (or any successor supplement or regulations).

13. GOVERNMENT END-USERS. The Software is licensed to the U.S. Government with RESTRICTED RIGHTS. Use, duplication or disclosure by
the U.S. Government is subject to restrictions as set forth in the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and
the Commercial Computer Software clause at 48 CFR 52.227-19, as applicable. Contractor/manufacturer is Sony Pictures Digital Inc., 6025 West
Slauson Avenue, Culver City, California 90231-3637.

14. MISCELLANEOUS. This Agreement will be binding upon and inure to the benefit of Sony and you, and our respective successors and permitted
assigns. If any provision of this Agreement is determined to be invalid or unenforceable, such determination will not affect the validity or enforceability
of any other provision of this Agreement. Any waiver of any breach or failure to enforce any provision of this Agreement will not be deemed a future
waiver of such term or a waiver of any other provision. Any waiver, amendment, supplementation or modification of any provision of this Agreement
will be effective only if it is in writing and signed by Sony and you. This Agreement shall be governed by the laws of the United States and the State of
California, irrespective of California's conflicts of laws rules. Any action arising out of or relating to this Agreement may be brought exclusively in the
appropriate state or federal court in Los Angeles, California, and Sony and you irrevocably consent to the jurisdiction of such courts and venue in Los
Angeles County, California. This Agreement constitutes the entire agreement between Sony and you with respect to the subject matter of this
Agreement. Sections 8 through 11 and 14 will survive the termination of this Agreement.

Revision 10/28/03.
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SOFTWARE PRIVACY POLICY STATEMENT

PLEASE READ CAREFULLY. YOUR USE OF THE SCREENBLAST® MOVIE STUDIO™, SCREENBLAST ACID®, ACID PRO, SOUND
FORGE® , SCREENBLAST SOUND FORGE, VEGAS® AND VEGAS + DVD, CD ARCHITECT™, DVD ARCHITECT™, NOISE REDUC-
TION PLUG-IN™, PRESET MANAGER 2.O, AND SUPER DUPER MUSIC LOOPER™ SOFTWARE (COLLECTIVELY, THE "SOFT-
WARE") IS SUBJECT TO THE FOLLOWING SOFTWARE PRIVACY POLICY STATEMENT ("PRIVACY POLICY").

Notice

Sony Pictures Digital Inc. ("Sony") respects your privacy and is committed to protecting personal information that you provide in connection with your use of the
Software. This Privacy Policy is intended to provide you notice of Sony's information management practices, including the types of information gathered, how the
information is used and safeguarded, and the degree to which you may control the maintenance and sharing of your information. Your installation of the Software
constitutes acceptance of this Privacy Policy in addition to the Software End User License Agreement ("EULA").

Personally Identifiable Information that We Collect

Sony may collect certain personally identifiable information about you through your use of the Software. If you elect to register the Software, Sony will collect cer-
tain information, such as your name, email address, mailing address and/or telephone number.

If you call or email our customer service center for support or technical assistance, you do so with the understanding that the customer service operator may col-
lect personally identifiable information from you and/or view and make changes to information that you previously provided us in order to provide the assistance
that you need.

Non-Personally Identifiable Information that We Collect

In order to record your installation of the Software, Sony might collect, among other things, information concerning your computer operating system.

Data Collection In the Software Start Up and Registration Process

In order to install the Software, you are required to review and agree to the terms of the EULA before completing the installation process. Upon first Start Up of
the Software, you may be required to enter the Software serial numbers provided by Sony. At that time, you may also elect to register the Software. Your comput-
er must be connected to the Internet in order to register the Software. The method of registration available will depend on the type of Software you have
obtained:

Standard Product Software

If you have received the full-functionality version of any Software in a CD ROM format ("Standard Product Software"), you must enter the serial number found in
your product package. You may then elect to register the Software. If you register the Software, Sony may use information collected about you to provide you with
updates about the Software and our services, as well as for marketing purposes. If you do not elect to register the Software, no personally identifiable information
will be collected or used in any way.

Downloadable Software

If you have received a version of any Software via download from the Internet ("Downloadable Software"), you must register the Downloadable Software within
30 days. Failure to register within 30 days will cause the Downloadable Software to disallow you from using it until you register. When you register your
Downloadable Software, you may register either "With Personally Identifiable Information" or "Without Personally Identifiable Information." If you register "With
Personally Identifiable Information," Sony may use the information collected about you to provide you with updates about the Software and our services, as well
as for marketing purposes. If you elect to register "Without Personally Identifiable Information," no personally identifiable information will be collected or used in
any way.

ACID XPress

If you have obtained ACID XPress software, you must register ACID Xpress in order to activate it. When you register, you will be asked to provide personally
identifiable information about yourself. Sony may use the information collected about you to provide you with updates about the Software and our services, as
well as for marketing purposes.

Trial Versions of Software

If you have received any trial version of the Software ("Trial Version"), you must register and provide personally identifiable information in order to use it. Sony
may use the information collected about you to provide you with updates about the Software and our services, as well as for marketing purposes.

Special Notice to Parents

Sony recognizes the sensitivity of personally identifiable information concerning children under the age of 13 and therefore provides this special notice. Sony is
committed to complying with all applicable laws and regulations regarding children, including the Children’s Online Privacy Protection Act ("COPPA"). If you have
purchased Software for your child who is under 13 and wish to register the Software, you should register with your own information to ensure that you will be
apprised of all product updates. If you provide registration information for your child who is under the age of 13, you will be deemed to have consented to the use
of your child's information for the Software registration and marketing purposes stated herein. Sony will not share your child’s personally identifiable information
with any third party (except for purposes of fulfillment by a third party that has agreed to protect the information in accordance with this Privacy Policy), unless
you specifically consent, or as permitted by COPPA or other applicable law. You may also subsequently request that your child’s information be removed from
active status in order for your child to not be contacted. If you wish to make such a request, or if you are a parent or guardian who has discovered that your child
under the age of 13 has submitted his or her personally identifiable information without your permission or consent, Sony will make reasonable efforts to remove
the information from active status, upon your request. To make a request, please send an e-mail to SonyPrivacy@sonypictures.com and be sure to include in
your message the Software serial number, if applicable, and your child’s email address that was submitted to Sony.
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Use and Disclosure of Information Collected

Sony uses information about you to deliver product updates, to inform you of other services or offers in which you might be interested, and to improve and
enhance our software. If you provide Sony with personally identifiable information, we will take all reasonable and appropriate steps to protect it from unautho-
rized disclosure.

If you provide your personally identifiable information to Sony as part of Software registration, you can opt-out of software-related marketing communications
from Sony at any time by visiting http://mediasoftware.sonypictures.com/corporate/contact.asp?id=11 and following the opt-out instructions. Likewise, with respect
to any newsletters or other email from Sony, you can always opt-out of receiving future mailings by following the directions contained in each newsletter to
"unsubscribe." However, if you opt out of receiving marketing communications, we reserve the right to contact you regarding your account status, technical sup-
port, product information, changes to a subscriber agreement, and any other matter that might affect our service to you and/or any products you purchased from
us or registered with us.

For further information about Sony's privacy and data collection policies for software, visit the Sony Web site at:
http://mediasoftware.sonypictures.com/corporate/privacy-software.asp.

When you provide us with personally identifiable information, we may share information about you within the "Sony Family". Likewise, other Sony Family busi-
nesses may provide us information about you in accordance with their respective privacy policies. You may receive occasional email offers and information about
other Sony products and services. If you do not wish to receive such information, you can opt-out by following the instructions in the email. The "Sony Family"
includes 1) Sony Corporation of America, 2) Sony Pictures Entertainment Inc., 3) Sony Music Entertainment Inc., 4) Sony Electronics Inc., 5) Sony Computer
Entertainment America Inc., 6) any company in which 25% or more of its outstanding shares are owned by Sony Corporation, directly or indirectly, 7) any com-
pany with "Sony" as part of its trade name and 8) any subsidiary of any of the foregoing Sony companies.

From time to time, Sony may use third party vendors to provide some services, including, but not limited to, database services, and the creation and distribution
of mailings and email offerings ("Third Party Services") on Sony's behalf. By installing the Software, you are deemed to consent to the use of these vendors. In
most cases, these vendors are contractually restricted to using personal information for the sole purpose of providing Third Party Services and are strictly prohib-
ited from sharing, selling, or otherwise distributing any personal data of our customers. Sony may also work with other Sony Pictures Entertainment Inc. busi-
nesses to provide some services, and those businesses will handle your personally identifiable information in accordance with this Privacy Policy.

Sony will not otherwise share, sell, rent, or disclose personally identifiable information that we have collected, except in the following circumstances: (i) we have
previously informed you of the disclosure, including by means of our Privacy Policy; (ii) we have been given your consent to disclose; (iii) we are required by law
or court order to disclose; (iv) disclosure is necessary to identify, contact, or bring legal action against someone who may cause or be causing harm to, or inter-
ference with Sony's rights or property or the rights or property of anyone else; or (v) to respond to an inquiry, request or complaint that you have made. Sony
may also use IP addresses in cooperation with Internet service providers to identify users if we deem it necessary to enforce compliance with this Privacy Policy,
the EULA, or applicable laws, or to protect the Sony Web sites, its customers, or others.

By installing the Software, you will be deemed to have consented to the disclosure to, and use by, a subsequent owner or operator of Sony of any information
about you contained in its databases, if Sony assigns all of its rights and obligations regarding your information at the time of a merger, acquisition, or sale of all
or substantially all of its assets to a subsequent owner or operator.

Our Commitment to Data Security

While Sony takes precautions against possible security breaches of its Web sites and customer databases, no Web site or Internet transmission is completely
secure. Consequently, Sony cannot guarantee that unauthorized access, hacking, data loss, or other breaches will never occur. Your use of the Software, the
Sony Web site and its services is at your own risk.

Consent to Processing in the United States

By providing any personal information to Sony pursuant to this Privacy Policy, all users, including, without limitation, users in the member states of the European
Union, fully understand and unambiguously consent to this Privacy Policy and to the collection and processing of such information in the United States of
America. You also consent to the provisions of the EULA.

Contact Us Regarding Privacy

Sony is dedicated to protecting your personal information and welcomes comments and questions on this Privacy Policy. You may e-mail your questions or com-
ments to SonyPrivacy@sonypictures.com. Please include in your message the name of your Software product.

Notification of Changes

Sony reserves the right to change this Privacy Policy, its EULA and the Terms of Service for the Sony Web site at any time by notifying registered users via e-
mail of the change and/or posting the revised document on the Sony Web site. All changes to the Privacy Policy, EULA and/or Sony Web site's Terms of Service
will be effective when posted, and your continued use of any Software after the posting will constitute acceptance of, and agreement to be bound by, those
changes.

Last Updated: 12/15/03
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Screenblast Movie Studio Software Package
The Screenblast® Movie Studio™ retail package includes the Screenblast Movie Studio 
application and the Sonic MyDVD application. The Screenblast Movie Studio software allows you
to get the most from your digital camera or camcorder by giving you the power to editing your
home movies, wedding videos, business presentations and more. The Screenblast Movie Studio
package also includes Sonic MyDVD application which provides you with a quick and easy way
to put your own videos on DVD discs that can be played on most DVD players and shared with
friends and family.

� Support Resources

� Registration Assistance

� Trouble Shooting & Technical 
Support

� Screenblast Movie Studio 
Software Features

T he Screenblast Movie Studio 
program is a powerful video 

editing software package that provides
everything you need to turn your videos
into memorable movies in minutes. 
The simple-to-use Screenblast Movie
Studio software makes video and 
audio editing fun, fast and flexible. 
Plus, a step-by-step instructional 
wizard that ensures  you’ll be up 
and editing in minutes. 
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Chapter 1: Welcome to Screenblast Movie Studio

Also Available:

Screenblast ACID 4.0 software package*
Another easy-to-use Screenblast software product, Screenblast® ACID® 4.0, gives you all 
the tools you need to make music. The Screenblast ACID 4.0 application lets you create, edit
and mix music with hundreds of music loops. And, the best thing is that files created with the
Screenblast ACID 4.0 application are compatible and interchangeable with the Screenblast
Movie Studio software.

*Sold separately, available at your local software retailer and at Screenblast.com.

ABOUT YOUR RIGHTS IN THE SCREENBLAST MOVIE STUDIO SOFTWARE

The Screenblast Movie Studio software is licensed to you under the terms of the End User License Agreement.
The End User License Agreement is first presented to you when you install the software. Please review the 
End User License Agreement carefully as its terms affect your rights with respect to the software. For your 
reference, a copy of the End User License Agreement for Screenblast Movie Studio is printed at the beginning 
of this manual.

About Your Privacy
Sony Pictures Digital and Screenblast respect your privacy and are committed to protecting personal information.
Your use of the software is governed by the Screenblast Software Privacy Policy. A copy of this policy is incorpo-
rated into the registration process and you are asked to agree to its terms prior to accepting the terms of the End
User License Agreement. Please review its contents carefully as its terms and conditions affect your rights with
respect to the information that is collected by the software. For your reference, a copy of the Screenblast
Software Privacy Policy is printed at the beginning of this manual.

Proper Use of Software
The Screenblast Movie Studio software is not intended, and should not be used for, illegal or infringing purposes,
such as the illegal copying or sharing of copyrighted materials. Using the Screenblast Movie Studio software for
such purposes is, among other things, against United States and international copyright laws and contrary to the
terms and conditions of the End User License Agreement. Such activity may be punishable by law and may also
subject you to the breach remedies set forth in the End User License Agreement.

Likewise, Screenblast.com does not promote using its services to swap or distribute illegal or infringing materials.
Using Screenblast.com for such activity may be a violation of United States and international copyright laws and
contrary to the terms of the Screenblast.com Terms of Service and the Audio-Visual Submission Agreement.
Such activity may be punishable by law or may subject you to the breach remedies set forth in the Screenblast
Audio-Visual Submission Agreement and/or Screenblast Terms of Service.
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Software Support Resources
This section of the Screenblast Movie Studio manual lists support resources to help you make
the most of your Screenblast Movie Studio software, including:

� Registration Assistance

� Troubleshooting/Technical Support

Registration Assistance
After the Screenblast Movie Studio application is installed and you start it for the first time, the
registration wizard will appear. This wizard offers easy steps that enable you to register the
Screenblast Movie Studio software online.

Registering your product, with contact information, will provide you with access to a variety of
technical support options, notification of product updates and special promotions exclusive to
registered users of the Screenblast Movie Studio program.

Assistance with registration and sales is available during normal office hours by dialing the
following numbers:

Telephone/Fax Country

1-866-727-6642
(toll-free)

United States, Canada and Virgin Islands
9:00 a.m. to 11:30 a.m. and 12:30 p.m. to 5:00 p.m. CST, Monday – Friday

1-608-204-7703
(phone)

All other areas 
9:00 a.m. to 11:30 a.m. and 12:30 p.m. to 5:00 p.m. CST, Monday – Friday

1-608-250-1745
(fax)

All Countries
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Troubleshooting/Technical Support
For technical software support, we encourage customers with Internet access to visit 
http://mediasoftware.sonypictures.com/support/default.asp, where you can access the extensive
Screenblast product Knowledge Base, link to discussion forums with other Screenblast

product users, and submit e-mail inquiries.
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Screenblast Movie Studio Software Features 
Here are some of the many features available in the Screenblast Movie Studio software:

Simple drag-and-drop operations Nondestructive editing

Unlimited undo/redo

Pan/crop tools for stills and video clips

Automatic crossfades between events

Markers and regions

Record narrations in real time

Audio and video time stretching

Multiple file formats on a single track

Two video and three audio tracks

Real-time event resampling

Video preview without rendering

Integrated DVD burning & over 40 exclusive DVD menus
from the Sony Pictures Digital Authoring Center

Encoding tools for the Web

Windows Media™ Video and Windows Media™ Audio
support – including Windows Media 9

Red-eye removal and still image animation

Video capturing and editing

Intuitive Windows® interface

Dual processor support

Digitize video straight from your camera

Features integrated Screenblast® Video Capture functionality

Interactive tutorials

Capture files and render projects larger than 4 GB

Chroma Keyer Plug-in for transparency effects

DV and MPEG-1 support

Support for most OHCI-compliant IEEE 1394/DV hardware

Support for timeline Metadata commands, including URL
flips and close caption for Internet content authoring

Support for any frame aspect ratio (4:3, 16:9) and pixel
aspect ratio

PAL and NTSC support  aspect ratio

Hundreds of effect and transition combinations

174 customizable video transitions

115 customizable video effects

Time compression/expansion of audio and video

Real-time effects previewing

Text animation, titling, and scrolling titles

Image correction tools  

Image panning 

Image cropping

Image cropping

Video overlay track

General

General

Output

Import

Editing

Loop recording

DV capture and print-to-tape tools

Automatic DV Scene detection

Import format support Audio: AIFF, MP3, OGG, PCA, W64, WAV,
WMA Video/Still Image: AVI, BMP, GIF, JPG, MMV, MPEG-1,
MPEG-2, PSD, PNG, QuickTime®, TGA, TIF, Windows Media® 9

Animated GIF input

MP3 audio input

Dual monitor support

ExpressFX available on every audio track

Export format support Audio: AIFF, MP3, OGG, PCA,
RealAudio®, W64, WAV, WMA Video/Still Image: AVI,
MPEG-1, MPEG-2, QuickTime®, RealVideo®, SWF,
Windows Media® 9
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What’s The Difference Between 
Digital Video and Analog Video?

The biggest change for video in the last few years has been the switch from analog video formats, 
such as VHS videotapes and VCRs to digital video formats, such as Mini DV camcorders and DVDs.
So what’s the difference between analog and digital video?  And why is it important?  

First off, it’s important to know that computers – and, specifically, the Screenblast Movie Studio software,
only edit digital video. Now, that doesn’t mean that you won’t be able to edit those old VHS or Hi8 tapes,
but first you will have to get your video converted into a digital video format.

In general terms, analog refers to something that varies smoothly and continuously while digital 
means something that is measured out in discrete units. It’s easy if you think of a clock. A digital clock
tells time by showing the exact numbers of the time. On an analog clock, the hands sweep smoothly 
past the numbers.

For video, the principle is much the same.
Video devices work by recording and playing back electrical signals that get translated into color values
and placement on the screen. For analog video, this is done with a continuously varying electronic signal
that is recorded on the analog videotape. With digital video, the values are first measured and turned into
discrete numbers called bits. Those bits are then stored on tape, hard drive, or other media such as CDs,
DVDs, and even such things as Sony Memory Stick® media.

The real power of digital video happens when you use a computer to store, edit, and perform digital video
effects – something you can’t do with analog video. That’s what Screenblast Movie Studio video editing
software does – it lets you work with digital video to create, edit, and even share your own video with
friends, family and fans.

Accurate storage and transfer

Digital video can be easily stored in a more precise form that can be duplicated, copied, or sent over the
Internet without what is called generation loss, or, the degrading of quality.

Higher Resolution

Higher video resolution means better picture quality. Analog video such as the VHS format has only 250
lines of resolution, while the miniDV digital format offers 500 lines – twice as much!

Better Color

Digital video also offers brighter and more accurate colors. In fact, by using a process called component
color sampling, three times more color information than analog VHS can be preserved.

Less Jitter, Less Error

Digital video uses technologies called time base correction and error correction to provide a better 
looking, more stable and more accurate picture.

Converting Analog Video to Digital Video

If your video source tape is already in DV digital format, you can easily capture it directly into your com-
puter using a USB, USB 2.0, or i.LINK® connector (IEEE-1394). However, if your video is analog, such as
VHS or Hi8, then you will have to convert it to digital before you can work with it in the Screenblast Movie
Studio software.

The process of turning analog video into digital video is called Analog-to-Digital Conversion and can be
done by either running the video through a digital camcorder or by using a video capture card. Take a
look at the section called Converting Analog Video into Digital Video for more information on how to get
analog video material on to your computer.
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� Minimum System Requirements

� Installing the Software

� Configuring Your PC

� Starting the Application

� Software Updates 
and Resources

� Configuring Your System  
for Video Capture

� Using Help and Tutorials

� Overview of Making a Movie

T his chapter will guide you through

getting your PC system set up to

run the Screenblast Movie Studio soft-

ware. You’ll also learn how to install and

start the application, how to use help

and tutorials, and get a quick overview

of the process of making a movie.

Screenblast Movie Studio Software Package
Digital Video makes a lot of demands on your computer system. For best results, you'll need to
make sure your computer meets the minimum specification provided below Before you install the
Screenblast® Movie Studio™ software.

Minimum System Requirements
In order to use the Screenblast® Movie Studio™ 4.0 software, your computer must satisfy the fol-
lowing minimum specifications:

� Microsoft® Windows® 98SE, 2000, or XP

� 400 MHz processor or above

� 128 MB RAM

� 40 MB available hard-disk space for program installation

� Windows-compatible sound card

� CD-ROM drive (for installation from a CD only)
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� 24-bit color display

� OHCI-compliant IEEE-1394 integrated port or capture card (for DV capture and
print-to-tape)

� Internet access (for online registration)

Video CD Burning:

� CD-R or CD-RW recorder drive

DVD Burning:

� DVD burner (works with DVD-RW/-R and with DVD+RW/+R)

� 10 GB free hard disk space (20 GB or more recommended)

� AGP video graphics card with at least 8 MB RAM

Installing the Screenblast Movie Studio Software
Prior to installing the Screenblast Movie Studio software, we recommend you exit all open 
applications and temporarily disable any virus protection program.

1. Insert the Screenblast Movie Studio CD-ROM into your CD drive. The Screenblast Movie
Studio installation menu will automatically display if the CD-ROM AutoPlay is enabled.

a. If the CD-ROM AutoPlay is turned off, click Start and choose Run. The Run dia-
log displays.

b. In the Run dialog, enter the CD-ROM drive’s letter and add :\setup.exe (e.g.
d:\setup.exe)

2. Click Install Screenblast Movie Studio to begin the installation process.

3. Follow the on-screen prompts and enter the necessary information where required.

4. At the final prompt, click Finish.

5. Repeat steps 3-5 for the other application.

Configuring Your PC for Best Performance 
It is not difficult to obtain professional-looking results from your digital video using the
Screenblast Movie Studio software, but much of your final product depends on the selection,
configuration, and capacity of all your system components. Here are our recommendations for
configuring your system for optimum performance when working with video:
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Processor Speed and RAM
At a minimum, we recommend that you have a 400 MHz processor and 128 MB of system RAM.
A correctly configured system with a faster processor and more RAM is helpful ; you will have
better playback, recording, and saving performance. However, if you have a slower processor or
less RAM, it will not affect the quality of the final product, but certain operations may take more
time.

Hard Drives
We recommend that you have plenty of available space on the hard drives where you will be
storing and editing your video. Your audio and video files will likely use quite a bit of hard drive
space. Using a dedicated hard drive for this purpose can improve the quality of video capture
and print to tape operations. In addition, prior to capturing or working with video, we recommend
running the Windows Disk Defragmenter utility for your hard drives As this may allow you to
avoid some of the problems encountered in these operations. To run this utility, follow these
steps:

1. Click the button on the Task bar and choose Programs.

2. From the Programs submenu, choose Accessories, followed by System Tools and
Disk Defragmenter. For more information on this utility, refer to its associated Help file.

Use of Other Software Applications While Capturing or Editing
Video 
The processes of capturing, recording, editing, and saving video and audio will use the majority
of your computer’s resources. We recommend that while you are working in the Screenblast
Movie Studio software, you shut down other software applications and screensavers.

Starting the Screenblast Movie Studio Application
After you have installed the Screenblast Movie Studio program, double-click the Screenblast
Movie Studio software icon on your desktop or click on the button on the taskbar and choose
Programs. From the Programs menu, choose Screenblast and then the Screenblast Movie
Studio software icon.

1. Click on the Screenblast Movie Studio software icon ( ) to open the application.

2. At the prompt, enter the Serial Number including all hyphens. The Serial Number is
located on the CD sleeve that came with your Screenblast Movie Studio box.
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3. Then choose your Registration option and click Next.

4. At the final screen prompt, click Finish.

Note: Your Serial Number is listed on the CD sleeve within your Screenblast Movie Studio box or 

in the confirmation e-mail that you received if you downloaded the software from the Web.

Screenblast Movie Studio Startup Screen 
When you first start the Screenblast Movie Studio Application, a startup screen offers the choice
between opening the Screenblast Movie Studio Tutorials or going straight into capturing video or
still images from an attached device such as a digital camera or camcorder. If you don’t want
this screen to appear every time you start the application, click in the box next to “show at start-
up” to clear it. If you don’t want to choose either of these options and want to simply open the
application interface to work on a project, click on the Close button at the bottom of the window.

Note: If you re installing the Screenblast Movie Studio software with Windows 2000 and XP, your user account needs to be a

member of the Administrators group to install the Screenblast Movie Studio program, and you need to be a member of the Power

Users group (or higher) to register the Screenblast Movie Studio program.

Software Updates and Resources 
Your Screenblast Movie Studio software has a new feature called XML Alerts that will automati-
cally check to make sure the software is up to date whenever the application is running while the
user is connected to the Internet.
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What You’ll Need to Capture Video
If you’re planning to create your own video footage, you’ll need the following equipment in addi-
tion to your PC:

� Digital video (DV) camera

� OHCI-compliant IEEE 1394 video capture card and cable

� The Screenblast Movie Studio software

–OR–

� Analog video camera

� Microsoft DirectShow-compatible video capture card and cable

� The Screenblast Movie Studio software
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Video Formats - Analog and Digital

There are now more formats for recording and playing video than ever before in history.
What are all these formats and why are there so many?  Since you can’t tell the players
without a program, here is a quick summary of the most popular video formats:

Analog. VHS-C (the C stands for compact) uses the same video technology as regular
VHS, and has the same resolution, but it uses tapes that are smaller than the standard
VHS size. These can only be played in regular home VCRs by using an adapter. The
maximum recording time of a VHS-C tape is 40 minutes.

Analog VHS-C Lines of Resolution (NTSC) = 250

Analog. S-VHS (the S stands for Super) is a higher resolution version of the VHS format,
which increases the standard VHS resolution of 250 lines to 400 lines. S-VHS tapes are
not compatible with standard VCRs and must be played with a special S-VHS deck.
Typical S-VHS camcorders have a maximum recording time of 2 hours.

Analog SVHS Lines of Resolution (NTSC) = 400

VHS

VHS-C 

S-VHS

Analog VHS Lines of Resolution (NTSC) = 250

Analog. VHS (Video Home System) is an analog video format developed in 1976. VHS
records at a resolution of 250 horizontal scan lines, which is a slightly lower resolution
than the 270 of 8MM, and only half the resolution of Digital Video. A standard T-120
VHS tape will hold 2 hrs of video.

Analog. The Hi8 format was released in to bring higher resolution to the 8mm 
tape format. Hi8 provides the improved 400 lines resolution used by S-VHS, 
and features the same maximum recording time of 2 hours.Hi8 

Analog Hi8 Lines of Resolution (NTSC) = 400

Analog 8mm Lines of Resolution (NTSC) = 270

Analog. The 8mm video format was released in 1984 to provide a more compact cam-
corder format than VHS. 8mm also had a few advantages over VHS in that it recorded
tracking data right on the tape and had a slightly better resolution than VHS at 270
lines. 8mm tape can record up to 2 hours of material.

8mm
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With the coming of digital formats (DV camcorders and DVD players), the analog formats have declined in
popularity over the past several years, although there are still millions of VHS format VCR players in use.

Keep in mind that you can’t move video recorded on an analog camcorder or VHS directly into the
Screenblast Movie Studio program.. You’ll need to first convert the analog video into digital video.

The process of turning analog video into digital video is called Analog-to-Digital Conversion and can be
done by running the video through a digital camcorder or by using a video capture card. Take a look at the
section called Converting Analog Video into Digital Video for more information on how to get analog video
material on to your computer.

Digital Consumer Video Formats
With the advent of digital camcorders equipped with an iLINK connector (IEEE 1394) or FireWire and USB
ports, it finally became possible to move video from the camcorder’s tape into a computer without requiring
the use of expensive video capture cards. Just as with analog video, there are a few different format vari-
eties you should know about…

Digital. Sony introduced the Digital8 video format in 1999 as a way of producing
better quality video using the same 8mm tape stock that is used for conventional
8mm analog video. The Digital8 format offers a superior horizontal resolution of 
500 lines with 12 or 16-bit digital sound.

Most Digital8® HandyCam® Camcorders were designed to be backward-compatible
with analog 8MM and Hi8 tape cassettes for the Hi8™ Handycam® Camcorder. This
means that users, who have an existing library of analog 8mm or Hi8 tapes, can
use a Digital8 camcorder for playback. The tape speed is twice that of analog, so a
2 hour 8MM tape will record 60 minutes when recorded in Digital8.

Digital 8 Lines of Resolution (NTSC) = 500

Digital8

Digital. Introduced Digital Video (DV) format recorders convert the image directly
into a digital signal in the camcorder and digitally record it on the tape. DV tape is
much smaller than VHS tape, making DV camcorders much smaller and easier to
handle. Maximum recording time for DV is up to 2 hours.

Digital DV and MiniDV Lines of Resolution (NTSC) = 500

Digital Video
Cassette

Some DV tapes even have built-in memory chips that allow you to build and store
a "Table of Contents" of the tape. This TOC can be automatically accessed to find
a particular recording date, index point or even add titling that can be turned on
and off during playback.

The resolution and quality of DV camcorders is twice that of VHS, with 500 
horizontal lines of resolution and superior color accuracy. The DV format has 
two cassette sizes: Standard/ Full Size (125mm by 78mm by 14.6mm) and 
MiniDV (66mm by 48mm by 12.2mm). DV camcorders use an iLINK connector
(IEEE 1394) or FireWire connection to allow fast and easy direct transfer of 
digital video from the camcorder to a computer for editing and archiving.

Digital DV and MiniDV Lines of Resolution (NTSC) = 500

Mini-Digital
Video
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Digital. Sony’s MicroMV format uses tapes that are 70% the size of a MiniDV tape,
but records at the same resolution. MicroMV tapes can store up to 60 minutes of
high quality video in the MPEG-2 format, the same format used in DVD players.
This makes it very easy to transfer material from the MicroMV camcorder into a
computer and onto DVD using the iLINK connector (IEEE 1394). MicroMV tapes
come with a built-in memory chip that automatically records a thumbnail index of
shots when the recorder starts and stops to allow for fast location of recorded
scenes.

Digital MicroMV Lines of Resolution (NTSC) = 530

Micro MV
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Configuring Your System for Video Capture
The following information will help you through the process of installing components and 
configuring your system to convert raw video into a multimedia presentation you can be proud 
to share with anyone.

1. Install your i.LINK (IEEE-1394/OHCI-compliant) video capture card according to the doc-
umentation included with the card. Once the card is installed, Windows should detect
your new hardware and install any necessary drivers for you. If it does not, install any
necessary Windows drivers from the original operating system CD.

DV users only: It is highly recommended that you do NOT install any third-party driv-
ers or editing software included with your capture card. Windows will automatically
install the proper native Windows driver, and the Screenblast Movie Studio software
installation will install all other needed components. Installation of third-party drivers
and editing software can cause problems with the Screenblast Movie Studio soft-
ware.

If you have a DirectShow-compatible video capture card, follow the manufacturer’s installa-
tion instructions.

2. Install the Screenblast Movie Studio software. For more information, see Installing the
Screenblast Movie Studio Software on page 9.

3. Connect your video camera to the video capture card using the cable provided with your
capture card.

Online Help/Show Me How Tutorials
The Screenblast Movie Studio software includes a number of resources to help you as you work.
In addition to this manual, there is also a detailed help system within the software and an extra
helpful feature called Show Me How tutorials.

Accessing In-Program Help
The in-program Help is available in two forms: the Main Help file and "What’s This?" Help file.
Both can be accessed by keyboard or via the Help menu.
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What is i.LINK®*

Over the years, many different types of connections have been developed to move
digital data between a computer and other devices. You may even remember some
of the older ones with names like Parallel and Serial. Today, most digital video cam-
corders and computers come with a connection that is commonly called IEEE
1394, FireWire, or i.LINK®*.

What’s so hot about i.LINK and why does it have all these different names?  Well,
here’s the scoop –

IEEE 1394 was developed as a way to move very large amounts of data between
computers and perhipherals. Some of the main goals of IEEE 1394 were to simplify
complicated cabling between devices, allow hot swapping of devices (plug and
unplug them while they’re on), and achieve fast transfer speeds of up to 400
megabits per second – really fast as far as these things are concerned. In fact, it’s
roughly thirty times the speed of a standard USB 1.0 connection. Since that’s fast
enough to easily transfer digital video and audio files, it turned out to be the most
useful way to connect digital video camcorders, computers, and other devices to
each other. When Sony implemented the IEEE 1394 standard for the VAIO comput-
er line and other devices such as Sony Digital Video (DV) camcorders, a user-
friendly name was chosen -- i.LINK.

The Screenblast Movie Studio video editing software supports the IEEE 1394 stan-
dard. If your DV camcorder and computer are IEEE 1394-capable, then the soft-
ware will very easily capture all of the video on your camcorder to the computer
through the easy-to-understand video capture interface.

So, whether you call it i.LINK, IEEE 1394, or FireWire that fast and easy connec-
tion between your DV camcorder and computer is a great way – in fact, the pre-
ferred way -- to move digital video and audio around.

*i.LINK is a trademark of Sony Electronics, used only to designate that a product
contains an IEEE 1394 connector. All products with an IEEE 1394 connector may
not communicate with each other.
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� Main Help Window

The Main Help window is accessed either by choosing “Contents and Index” from the Help
menu or by pressing the F1 key. This window has four tabs that you can use to find the infor-
mation you need.

� The Contents tab provides a list of available help topics. Click on a closed book
( ) to open the pages, and then on the topic page ( )that you want information
about

� The Index tab provides a complete listing of the Help topics available. Scroll through
the list of available topics or type a word in the text field to quickly locate topics relat-
ed to that word. Select the topic and click the Display ( ) button.

� The Search tab allows you to enter a keyword and display all of the topics in the in-
program Help that contain the keyword you have entered. Type a keyword in the text 
field and click on the List Topics ( )button. Select the topic from the list and
click the Display button.
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What’s This? Help
What’s This? Help allows you to view pop-up window descriptions for Screenblast Movie Studio
menus, buttons, and dialog boxes.

� To Use “What’s This?” Help:

1. Choose “What’s This?” from the Help menu

- or -

2. Press the Shift+F1 keys or 

- or -

3. Click the “What’s This?” ( )help button on the toolbar 

4. The cursor changes to a “? ” ( )

5. Then click on any item in the Screenblast Movie Studio Program window to get informa-
tion about  that item

6. To use “What’s This?” help in a dialog box, click on the question mark button ( ) in the
upper right corner of the dialog box, then on an item in the dialog box.

Show Me How Tutorials
The Movie Studio program also utilizes a Show Me How feature ( ) that walks you
through the basics of any project. You are given the option to open this guide every time you run
Movie Studio software; deselect the Show at Startup check box to turn this feature off. You can
access the Show Me How tutorials at any time by choosing Show Me How from the Help menu.
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Quick Overview – Making a Movie with Screenblast Movie Studio
Software
This section provides a quick overview of the movie-making process on your PC.

1. Use the Screenblast Movie Studio program to locate media (audio and video) files to
add to your project. You can do this using any of the following options:

� Open existing files using the Media Pool or Explorer tabs.

� Use the Screenblast Video Capture™ feature to capture video from your video
camera.

� Get photographs from a scanner or digital camera using the Get Photo option.

� Extract audio from an existing CD.

� Record your own audio

2. Arrange audio and video clips on the timeline in the Screenblast Movie Studio software.

3. Add effects, transitions, and titles as desired – be creative!

4. Use the Make Movie wizard to render an output file of your project that you can share
using any of the following methods (these are explained in detail in Chapter 7):

a Burn Your Movie To DVD

b. Write Your Movie To Video CD Or CD-ROM

c. Save Your Movie To Sony® Memory Stick® Media Or Sony Giga Vault™ Portable
Hard Disk Media

d. Save Your Movie To Your Camcorder’s  DV tape

e. Send Your Movie Via E-mail

f. Create an HTML Page That Includes Your Movie

� Analog video camera

� Microsoft DirectX Show-compatible video capture card and cable

� The Screenblast Movie Studio software

MovieStudio_ FINAL_EN.qxd  2/24/04  11:50 AM  Page 20



SCREENBLAST MOVIE STUDIO SOFTWARE 21

USB 1.1, USB 2.0, and the i.LINK Connector – 
What’s the Difference?

The last few years have seen the development of new ways to move data in and out of
computer systems. The most popular of these are the new digital serial communica-
tions interfaces called USB 1.1 (usually just called “USB”), the new improved USB 2.0
and, of course, the i.LINK connector (also called IEEE 1394). What are the differences
and what are they used for? 

USB 1.1

USB stands for Universal Serial Bus. It was created as a better way to handle 
connecting peripheral devices such as printers, scanners, digital cameras, audio 
interfaces, and others to computer systems. One of the key concepts behind USB is
to facilitate the easy Plug and Play philosophy for hardware peripherals. The interface
has made it possible to hot-plug devices into the system and is much faster and more 
flexible than older interfaces such as the RS-232 serial interface and the common 
parallel port. The current version is USB 1.1 which supports data transfer rates up to
12 Mbps. This works well for slower speed peripherals and even some low-resolution
video cameras.

USB 2.0

USB 2.0 provides three different speeds -- 480 Mbps, 12 Mbps, and 1.5 Mbps.
Sometimes the term "Hi-Speed USB" is also used.

USB 2.0 is relatively new. If you want to use a USB 2.0 device, it is important to 
make certain that your computer and perhipherals are USB 2.0 compatible and 
that the manufacturer of that device also supplies the appropriate device drivers 
for your operating system.

i.LINK Connector (IEEE 1394)

The i.LINK connector (IEEE 1394) is primarily an audio/video interface can transfer
data at speeds up to 400 Mbps, which makes it ideal for transferring video footage
from your camcorder to your PC. While USB 2.0  can transfer data at slightly faster
rates (480 Mbps), it is still a new technology and there can be differences in how it is
implemented on newer computer chipsets and peripheral devices. Also, USB 2.0 still
requires a host computer for support, while the i.LINK connector (IEEE 1394) can be
used directly between devices and does not require computer support.
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The Screenblast Movie Studio Application Interface
The following screenshot of the Screenblast Movie Studio software shows the location of the
major sections of the interface. Each of these main sections will be described in greater detail
later in this chapter.

Note that the number and arrangement of  icons in the main toolbar can be changed by using
the feature called Customize Toolbar in the Options menu. The most commonly used toolbar
items are described here.

� Overview of the Movie Studio
Application Interface

� Toolbars

� Marker Bar

� Track Header

� Timeline

� Transport Bar Controls

� Multifunction Area

This chapter provides an overview of

the components of the Screenblast

Movie Studio program interface. You’ll

see that many of the Screenblast Movie

Studio software operations, menu items,

and shortcut keys are consistent with

other popular Windows software 

applications. 
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Marker Bar

Ruler

Timeline

Transport Bar

Video Preview

Menu Bar
Main Toolbar
Time Display

Track
Header

Multifunction 
Area

Divider

Command Bar Track View

�Main Toolbar

The main toolbar, located at the top of the main application workspace, allows you to quickly
access the most commonly used functions and features in the Screenblast Movie Studio software.

Create new project

Open existing project

Save project

Display project properties

Undo command

Redo command

Enable snapping

Enable ripple edits

Ignore event grouping

Normal edit tool

Envelope edit tool

Split event

Insert text media

Make Movie wizard

Show Me How tutorials

What’s This? Help
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�Multifunction Area Toolbars

The toolbars on the Media Pool and Explorer tabs allow you to quickly access the common
functions in these areas.

Import media

Capture video

Get photo from scanner or digital camera

Extract audio from CD

Remove selected media from project

Display media properties

Start preview

Stop preview

Auto preview

Views

Up one level

Refresh

New folder

Add to my favorites

�Marker Bar

The Marker Bar is the area where informational tags may be placed, named, and positioned
along the project’s timeline. These can serve as cues or reminders highlighting important
events in your project.

Marker Bar
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�Track Header

This area identifies the track audio or video order in your project and contains controls used
to determine audio track mixing.

�Timeline

All arranging and editing is done in the timeline window. This area contains all the project’s
events.

�Transport Bar Controls

The Transport bar, located under the timeline, contains the playback and cursor positioning
buttons frequently used while working on and previewing your project.

Video Tracks

Audio Track

Timeline

Track Mode
Controls

Track Name

Loop playback

Play project from cursor position

Pause project playback

Stop playback

Move cursor to start of project

Move cursor to end of project
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�Multifunction Area

This area contains many of the functions vital to your project, such as locating files, adding
transitions, adding effects, adding text and backdrops, mixing audio, and previewing video.

Each part of the multifunction area is explained in the following sections.

Drag divider to change size of area

� Media Pool Tab – Alt+1

The Media Pool tab is used to collect and quickly access all media files you have added to
your project. You can also use the Media Pool tab to preview all of the files in your project.
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� Transitions Tab – Alt+2

The Transitions tab contains all of the transitions available in the Screenblast Movie Studio
software. Available transitions are listed on the left, and all presets for that transition are 
displayed in the area to the right. The thumbnails display animated examples of each tran-
sition and preset.

Transitions can be dragged from this window to the edge of an event or between two video
events. For more information, see Adding Transitions on page 77.

� Video FX Tab – Alt+3

This tab displays all of the effects available to apply to your video events or your entire proj-
ect. The available effects are listed on the left, and all presets for that effect are displayed in
the area to the right. The specific presets that are available depend on the selected effect.

Video effects can be dragged from this tab and dropped on video events.
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� Text and Backdrops Tab – Alt+4

This tab displays all of the text, titles, and colored backgrounds available to add to your proj-
ect. The available text and backdrop options are listed on the left, and all presets for that text
or backdrop are displayed in the area to the right. Text and backdrops can be dragged and
dropped onto the timeline. This will create a new event with a default duration of five seconds.
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Select 
drive
or folder.

Chapter 3: Movie Studio Interface Overview

� Explorer Tab – Alt+5

The Explorer tab is similar to the Windows Explorer. Use the Screenblast Movie Studio soft-
ware Explorer window to select media files to place into your projects.

� Audio Mixer

The Audio Mixer gives you access to your project’s audio properties and output levels.

Preview selected media file before you place it in the project.

Select media to place in the project by dragging and dropping onto the timeline or by double-clicking.

Right click on a meter to
change its settings
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Chapter 3: Movie Studio Interface Overview

Video will appear during project playback or as the cursor is moved during editing.

� Video Preview

This Video Preview displays a project’s video event during project editing and playback.

Right-click to change Video Preview settings.
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� What is a Media File?

� Timeline Vs Storyboard Editing

� What is an Event?

� What is a Track?

� Scrolling and Zooming

� Details on the Track Header

� Arranging, Moving, Selecting, 
and Grouping Events

� Digital Data Sizes and Rates

� Video Standards – NTSC, PAL, 
and SECAM

T his chapter provides details on 
the fundamental concepts and

operations of the Screenblast Movie
Studio software. It also includes useful
information about the differences
between storyboard and timeline editing,
digital data terminology and world 
video standards.

What Is a Media File?
In the Screenblast® Movie Studio™ software, you will mostly be working with video and music
files that are stored on any of your hard drives or in external media such as your personal music
or data CD-ROMs.

The Screenblast Movie Studio program is a non-destructive editor. This means that the software
package does not operate on or change files physically. Files can be accessed from the
Screenblast Movie Studio software’s Media Pool or Explorer.

What is an Event?
An event is an individual media file or a portion of a media file that has been inserted into the
Screenblast Movie Studio software timeline. When you drag a media file onto the timeline, you
are automatically creating an event that contains that file’s contents. That is, you’re copying all or
only a portion of your sound or movie file into the Screenblast Movie Studio software so it can
be manipulated. The event may only contain a small portion of a much larger media file.
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Timeline Editing – Best Tool for the Job

When it comes to editing a video project, there are two main styles used by different video edit-
ing software packages – Storyboard and Timeline. Screenblast Movie Studio video editing
sofware uses the Timeline style. Which is the best way to tell your tales? Here’s a brief look at
each…

Storyboard editing can provide a simple way to make a rough assembly of video clips with sim-
ple transitions. In a storyboard you choose the sequence of shots you want to use and throw
them together on a grid layout that simply shows a key frame from each clip. However,  the sim-

plicity of storyboard editing is also its biggest weakness. That’s because Storyboard style does-
n’t graphically show the relative length and importance of each clip, nor is it easy to do some of
the important effects and transitions that go into make an entertaining video production.

Storyboard editing can also be very limited in the view it provides – each clip takes the same
amount of space in the Storyboard, no matter how long or short the clip. Storyboard editing
also provides a very limited view of the transitions used between clips as well as the detail of
the different project elements such as video overlays, audio, titles, graphics, and effects.
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A single media file can be used repeatedly to create any number of different events, since each
event can be trimmed and inserted independently.

Events are the most basic objects in a Screenblast Movie Studio software project. An event is
something that happens in time and has a specific duration. In the Screenblast Movie Studio
software, a project event can contain video, audio, still images, and some special generated
media. Audio events are created from audio files on your computer (e.g., .wav or.mp3 files) or
can be a part of a video file (e.g., .avi or .mov). An audio event can contain an entire audio file
or only a portion of it. It can be modified with effects to change many of its characteristics, such
as speed, volume and equalization. Audio events can be mixed with other audio events.

On the other hand, Screenblast Movie Studio video editing software uses the other type of editing
style – Timeline editing. Timeline editing is also simple in that it allows you to throw all of your
video and audio clips together in the order that you want, but it also allows for greater accuracy
and much more detailed editing if you want it.

The Timeline accurately shows the relative time taken by each event and adds another dimension
by showing each video, audio, and effects track separately: Timeline editing lets you see and
work with each of the elements of the production independently with full awareness of how it will
impact the rest of the material in the project. With better control and a more comprehensive
overview, the Timeline used in the Screenblast Movie Studio video editing software gives you a
real advantage in making great movies:

� More intuitive visual feedback

� More detailed view of elements

� More editing control

The bottom line is that every editing program that professionals use to make video productions
employs the Timeline editing style. With the Screenblast Movie Studio video editing software,
you’ve got the tools to create big league results at home!

Timeline Editing – Best Tool for the Job
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Video events are created from video files captured to your computer (typically .avi, .mov, or
.mpg) or images (.bmp, .jpg, .png, .tga or .tif). A video event can be the whole file or a small sec-
tion of that file. It can be modified with effects (FX) to change many of its characteristics, such as
speed, color, and size. Video events can appear on top of (overlay) other video events. Overlays
can be video files, still images, titles or other graphics and logos.

What is a Track?
The Screenblast Movie Studio software has five basic tracks that are used to layout and organ-
ize your video project. There are two video tracks to contain the visual elements (e.g. video,
images, titles) and three audio tracks for audio elements (e.g. ambient sounds, music, narration).

The event as it appears in the Screenblast Movie Studio software
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The five tracks start out with preset names to indicate typical usage. These names can easily be
changed and the tracks can be used in whatever way works for you.

1. Video Overlay – Anything in this video track appears over or on top of the second track.
This track is designed to allow you to put titles, logos and other overlay graphics into
your project. Images and video can also be put into this track, but any media in the over-
lay track that is not at least partially transparent will completely obscure anything in the 
second track.

2. Video – This track is designed to be the primary video track. This media always appears
below or under the media from the first video track and may be completely covered by
any media in that track.

3. Voice – The three audio tracks are identical in nature and do not have a particular hier-
archy. The names are only suggestive of function. The voice track can be used for narra-
tions and voiceovers, or any other type of audio.

4. Music – This track can be used for background music or any other type of audio.

5. Sound Effects – This track can be used for adding sound effects, Foley effects, or any
other type of audio.

Once an event is placed on a track, you can use the track controls to affect the event or events
contained within the track. The following illustration shows the track controls for an audio track.

Toggling the Track Size 
You may change an individual track’s height in the timeline by clicking the View buttons ( )
on the track. Alternatively, you may use the Ctrl or Shift shortcut keys on your keyboard totoggle
through different track-height settings. The shortcut keys affect all tracks in your project and
make them the same height. You may resize a track by dragging the bottom border.

Track Name Record Track effect

Menu

Multipurpose fader Mute
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Scrolling and Zooming
It is easy to scroll and zoom in the Screenblast Movie Studio software workspace.

� Click the scroll bar arrows in the Screenblast Movie Studio software to move up and
down in the tracks or move forward and back along the timeline.

� Drag the scroll bars to move up and down the tracks or move forward and back
along the timeline.

� Click the Zoom tools ( ) to reveal more or less of the timeline.

� Drag the edge of the scroll bar, as a zooming shortcut or press the up and down
down arrow keys.

� From the Edit menu, choose Editing Tool, and then choose Zoom. In this mode, drag
on the timeline to draw a rectangle that defines the zoom region.

Zooming directly controls the accuracy of your editing. Each video event has thumbnail repre-
sentations of the frames within the event. Depending on how far you have zoomed in on a video
event, this thumbnail can be one image representing the entire event, or every frame can be dis-
played as a thumbnail. The first and last thumbnails always represent the first and last frames of
video in an event.
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The Screenblast Movie Studio program also has mouse scroll wheel support. The behavior of
the wheel depends on the position of the cursor in the workspace.

� The default behavior of the mouse wheel is to zoom horizontally.

� Shift+wheel scrolls horizontally (through time).

� Ctrl+wheel moves the timeline cursor in small increments.

� Ctrl+Shift+Alt+wheel moves the cursor in one-frame increments.

� Pressing the mouse wheel activates auto-panning.

Details on the Track Header
The Track Header is the area to the left of the track timeline. It contains a number of useful con-
trols for managing the operation of the tracks.

Changing a Track’s Color:
Each track has a color that is used as a background behind the icon that identifies what kind of
track it is (video, audio, text). The track color is also used to highlight an event when it is select-
ed. It may sometimes be useful to change a track’s color to make it easier to identify or to set
several tracks to the same color (for example all of the audio tracks) as a way to identify a group
of tracks with similar function. Here’s how it’s done:

1. In the Track Header, right-click on a track to display a shortcut menu.

2. From the shortcut menu, choose Track Display Color to display a submenu of available
colors.

3. Click the desired color. The track color is changed.

Mute Button
This button enables you to temporarily disable playback of the track, so you can focus on 
other tracks.

Track Name
This area lets you label a track. Double-click in the area and type the track’s name or right-click
anywhere in the Track Header and choose Rename from the shortcut menu and then type the
track’s name. If you do not see the Track Name, change the track’s height or width.
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Multipurpose Fader
This fader, found only on audio tracks, controls both the volume and pan for the audio track.
When set to Vol, the fader controls the audio track volume relative to the other tracks when it is
played back. The Screenblast Movie Studio software audio tracks are preset at 0.0 decibel (dB).
Use this fader to emphasize or de-emphasize a particular track. A track’s volume range is -inf. to
12 dB. Drag the fader knob left and right to adjust the volume.

When set to Pan, this fader adjusts the audio signal’s output left or right. As you move the slider,
the Screenblast Movie Studio software displays the signal’s percentage going to either the left or
right channel. For example, moving the slider to 60%L means that sixty percent of the signal is
mixed to the left channel, while 40% is mixed to the right. The Screenblast Movie Studio applica-
tion’s audio tracks are preset to center the signal between the left and right channel.

Inserting Media
Video and other image files must be inserted into one of the two video tracks while music and
sound files must be inserted into one of the three audio tracks.

Arranging Files on the Timeline
Once you’ve assembled the media files for your project, you’re ready to begin arranging them on
the timeline (although you can add more media files to your Media Pool at any time in the cre-
ation process). The Screenblast Movie Studio program has two video tracks for arranging files
such as video and still photos, and three audio tracks for arranging files such as music, voice,
and sound effects.

From the Media Pool or Explorer tabs, there are two ways you can add files to the timeline: by
double-clicking, or by dragging and dropping the file. Once a file is inserted into the timeline, it is
called an event.

Before inserting the file on the timeline, you should specify in which track you want to position
the event by clicking once on the track to select it. If you use the double-click method to place
the file, the event is placed at the current cursor position on the selected track. If you use the
drag-and-drop method to place the file, you control the location of the event by releasing the
mouse button. You can add events from multiple media files and file types to a single track, with
the restriction that audio files must be placed on audio tracks, and video files must be placed on
video tracks. Once an event is positioned on a track, you can always move it around on the
track, or you can move it to a different track until you are satisfied with its placement.

For more information on moving events, please see Moving Events Along the Timeline below.
For more information on selecting events, please see Selecting Events on page 40.
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Media files with video frequently include associated audio. When you insert a media file into the
timeline, the associated audio is automatically inserted into a separate audio track below the
video track. The two associated events are grouped together and behave as a single unit when
moved or otherwise edited.

To place multiple events:
1. Select multiple events in the Media Explorer or the Media Pool. Select a range of adja-

cent media files by holding down the Shift key and clicking files in the list view or select
files that are not adjacent by holding down the Ctrl key and clicking files.

2. Right-click and drag the files to the timeline.

3. Before you drop the files, select a placement option from the pop-up menu.

� Add Across Time: this option adds the events adjacent to each other across time.

� Add As “Takes”: using this option, you will see one event on the track. The other
events are listed as “takes” beneath the top-most event.

� Video Only and Audio Only: these options allow you to isolate either the video or
audio, and add that stream from a multimedia file either across time or as takes.

Note: A left-click drag-and-drop automatically inserts the events across time.

Moving Events along the Timeline
Events may be moved along the timeline individually or as a group. The left edge of an event 
is its starting point. Therefore, where the left edge lines up on the ruler determines when the
event starts.

Events may overlap each other or be placed on top of each other.

Moving a Single Event
You can move an event along the timeline within a track or move it to a different track.

MovieStudio_ FINAL_EN.qxd  2/24/04  11:51 AM  Page 39



SCREENBLAST MOVIE STUDIO SOFTWARE40

Chapter 4: Learning the Basics

� To move an event:

1. Select the event by clicking on it. The event is highlighted in the track’s color.

2. Drag the event along the timeline.

If you move the event along the original track’s timeline,
the event’s appearance (color) remains the same.

However, you may move the
event to a different track.
When you do, the event
appears as a simple outline
and you will see its original
track and position on the
timeline.

Moving Multiple Events 
You can move multiple events along the timeline within a track or move them to a different track,
similar to the previous procedure. In addition, selected events do not need to be within the same
track. You may select events on different tracks and move them as a group along the timeline.

� To move an event:

1. Use the Ctrl key, the Shift key, or the Selection Edit Tool (accessible from the Edit menu
by choosing Editing Tool, followed by Selection) to select the events. For more informa-
tion, see Selecting Multiple Events on page 41.

2. Place the mouse cursor over one of the selected events

3. Drag the events along their respective timelines.

Selecting Events 
The Screenblast Movie Studio software gives you the flexibility to select one or more events, 
a time range, or events and a time range. All selection options can apply to a single track or 
to multiple tracks.

To select an event, simply point and click on it.

Original track position

New track position
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Selecting Multiple Events
By using the Ctrl key, the Shift key, or the Selection Edit Tool (accessible from the Edit menu by
choosing Editing Tool, followed by Selection), you can select individual or multiple events in 
your project. Multiple events may be selected within a track or across tracks. Once events are
selected, you may apply any of the Edit menu commands, switches or editing shortcut keys to
them collectively.

Note: Media-specific (audio or video) effects and switches can only be applied to 

multiple events of the same type (e.g. Reverb can only be applied to audio events).

Whichever method you choose, you may or may not include events from a selection area by
holding down the Ctrl key and clicking on an event. The most common mode of operation is to
select events by clicking on them while in Normal Edit mode. While this is the default editing
mode, click the Normal Edit Tool button ( ) or, from the Edit menu, choose Editing Tools and
then choose Normal to switch back to this mode.

� To select nonadjacent events:

1. Hold the Ctrl key.

2. Select the events by clicking on them. To unselect an event, simply click it again to tog-
gle the event selection on or off.

Selected events

Selected events
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� To select a block of events:

1. From the Edit menu,
choose Editing Tool,
followed by Selection.

2. Position the cursor in a
corner of the area that
you want to select.

3. Click and hold the left
mouse button.

4. Drag the cursor to the
opposite corner of the
area you want to
select. A rectangle is
drawn on the work-
space. All events within this rectangle will be selected. To unselect individual events in
the middle of a selection area, hold the Ctrl key while clicking on the  events. To deselect
all of the events, click anywhere in the workspace outside of the selected events.

Hold down the left mouse button and right-click to toggle through the three types of selection
boxes: Free, Vertical or Horizontal.

Once events have been selected, they can be grouped together.

Selecting a Time Range 
The Screenblast Movie Studio software has a time selection bar that is located above the ruler.
This bar displays, with a shaded box, the time range that you have selected. You may use the
time selection bar for playing back a smaller portion of your project or to apply cross-track edits.

Time Selection bar
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Hold down the left mouse button and right-click to toggle through the three types of selection
boxes: Free, Vertical or Horizontal.

Hold down the left mouse button and right-click to toggle through the three types of selection
boxes: Free, Vertical or Horizontal.

� To select a time range:

1. Click the mouse pointer above the ruler (on the Marker Bar) and drag to select a region.
All events, or portions of events within the region are highlighted.

2. Click and drag the yellow handles on either end of the time selection to increase or
decrease your time range selection. You may move the entire selection range by drag-
ging the time selection bar.

Selecting a time range does not automatically select events. All items within the time range will
play back and be affected by Edit menu commands.

Only the events within the
time selection will be affect-
ed by edits or be played
back.
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Grouping Events
The Screenblast Movie Studio program allows you to group events together within tracks or
across separate tracks. Once a group is created, all the events within it may be moved together
as a unit and have event-specific edits applied at the same time. You may still edit properties of
individual events within a group without affecting the other group events. Grouping is useful
when you want to preserve timing of events and move them together along the timeline.

To Create a New Group:
1. Select the events you want to group. Press the Ctrl key, the Shift key, or use the

Selection Edit tool (accessible from the Edit menu by choosing Editing Tool, followed by
Selection) to select them. For more information, see Selecting Multiple Events on
page 41.

2. After the events are selected, you may group them in either of two ways:

� Right-click on one of the selected events to display a shortcut menu. From the short-
cut menu choose Group, followed by Create New.

� Press G to create the group

To Add a New Event to an Existing Group:
1. Select an event in the existing group.

2. Right-click the event and choose Group, followed by Select All to select all of the mem-
bers of the group.

3. Press the Ctrl key and click on the event to be added to the group.

4. Right-click the event and select Group, followed by Create New.

Note: Events can only be in one group at a time. Adding an event to an existing group essentially deletes the old group and cre-

ates a new one that includes all of the selected events.
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Removing Events from a Group
Individual events may be removed from a group without affecting the other members of the
group. The event you are removing from the group is not deleted from the project, but remains at
its timeline position.

� To remove an event from the group:

1. Right-click on the event you want to remove from the group to display a shortcut menu.

2. From the shortcut menu, choose Group, followed by Remove From on the submenu. The
event is removed from the group. The rest of the grouped events remain intact.

Selecting All Members of a Group
While grouped events move together, selecting one member of a group does not automatically
select every member of that group.

� To select all members of a group:

1. Right-click one of the members of the group.

2. From the shortcut menu, choose Group, followed by Select All, or press Shift+G on your
keyboard

Temporarily Disabling Grouping
To temporarily disable the grouping behavior of all groups (including video media files with
included audio streams) in the Screenblast Movie Studio software, click the Ignore Event
Grouping ( ) button on the main toolbar.

Playback and Preview
You can easily playback your project or preview specific events or transitions.

Playback From Within the Screenblast Movie Studio Program

The Screenblast Movie Studio program has a Transport Bar that allows you to play back your

entire project or portions of your project

based on either a time selection or the cur-

rent cursor position.

Play from cursor position Stop Cursor to end

Loop play Pause Cursor to start
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Digital Data Sizes and Rates – Bits, Bytes, and Gigs

You may hear terms like Megabyte (MB), Gigabyte (GB), Megabits per second (Mbps),
etc. tossed around a lot when dealing with computer storage and data transfer rates.
Data isn’t measured by the spoonful or by the pint. But what does it all mean?  It’s 
actually fairly simple.

A computer works by storing and processing digital bits. The bit is the most basic unit for
data and it can have one of two values – zero or one. Since it’s useful to deal with 
a bigger number than just the two values, computer engineers long ago came up with
the idea of a chunk of data comprised of 8 bits, which they called a byte. A byte is a
series of eight bits and can represent any number between 0 and 255, for a total of 
256 values.

By adding the prefix multipliers such as Kilo (x 1000), Mega (x 1 million), Giga (x1 
billion), and so on, we come up with the common terms used in the digital world for
measuring digital data. Here are some useful charts to show you how quickly it all 
adds up:

The numbers get very large very fast. For example, something like an Exabyte DVD
does not exist, nor may it ever. But, if it did, WOW!  It would hold approximately a 
quarter of a billion movies (1024 Gigabytes x 1024 x 1024 / 4.7).

Network Data Transfer Rates

When you send this data around on networks or over the Internet, data transfer rates
are calculated in terms of bits per second. Again, the prefixes Kilo, Mega, and Giga
come in handy to scale the sizes up. You’ll often see these terms used to indicate the
speed of data transfer rates for connections such as USB or i.LINK®, or for wireless
devices such as the Bluetooth® connection used in some Sony digital video cameras.

For reference:

• A High Density floppy 
disk holds about 1.3 
Megabytes (MB) of 
data.

• A CD holds about 
760 MB

• A single layer DVD 
holds 4.7 Gigabytes 
(GB).

Digital Data Chart

Data Unit Size

Bit Single Binary Digit (1 or 0)

Byte 8 bits

Kilobyte (KB) 1,024 Bytes

Megabyte (MB) 1,024 Kilobytes

Gigabyte (GB) 1,024 Megabytes

Terabyte (TB) 1,024 Gigabytes

Pentabyte (PB) 1,024 Terabytes

Exabyte (EB) 1,024 Pentabytes
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To give you a feeling for how this works out in practical application, the 
standard USB 1.1 connection moves data at up to 12 Mbps, whereas the
i.LINK connection on a digital video camera can transfer data at to 400Mbps.

Internet Connection Speeds

And finally, when you upload or download media files to online service, how
fast does your Internet connection move them? Here are some common types
of network connections and their relative speeds:

Data Transfer Rates Data Rates/second
in bits

Data Rates/second
in Bytes

Data Rates/second
in KB and MB

Data Transfer Rates

Kbps or Kb
(Kilobits per second) 1,000 Bits 125 Bytes

_

Mbps or Mb
(Megabits per second) 1,000,000 Bits 125,000 Bytes 122 Kilobytes

Gbps or Gb
(Gigabits per second) 1,000,000,000 Bits 125,000,000 Bytes 119 Megabytes

Data Transfer Rates

Technology Data Rate in Kilobits/second Data Rate in Kilobytes/second

28.8K Modem 28.8 Kps 3.5 Kilobytes

36.6K Moden 36.6 Kbps 4.4 Kilobytes

56K Modem 56 Kbps 6.8 Kilobytes

ISDN 128 Kbps 15 Kilobytes

T1 1.544 Mbps 188 Kilobytes

DSL 512 Kbps to Mbps 976 Kilobytes

Cable Modem 512 Kbps to 52 Mbps 6,469 Kilobytes (6.3 MB/sec)

T3 44.736 Mbps 5,460 Kilobytes (5.3 MB/sec)

Gigabit 1 Gbps 122,070 Kilobytes (119 MB/sec)
Ethernet
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To Play Back an Entire Project:
1. Click the Cursor to Start button to move the cursor to the beginning of the project.

2. Click the Play button to start playback.

3. Click the Stop button to stop playback.

Most of the time, you will only want to preview a small portion of the project to perfect a section.
To do this, create a time selection.

To Play Back a Time Selection:
1. Click the mouse above the ruler (on the Marker bar) and drag to select the time region.

To increase or decrease the time selection, click and
drag its start and end points. The time selection bar
appears above the ruler on the timeline.

2. Click the Play button to begin playback. Only the non-
muted tracks and events within the time selection will
play back.

3. Click the Loop button to toggle the Screenblast Movie Studio software to continually
play back the events within the time selection. Click it again to toggle this feature off.

4. Click the Stop button to stop playback.

By looping the playback, you can repeatedly watch the same section of the project over and
over as you make changes to effects in real-time. Selection areas can be quickly defined auto-
matically, depending on what you would like to preview:

� Double-click any event to set the preview range to the duration of that event. This is
useful if you are modifying an event with some kind of effect or transition and you
want to check the results.

� Press Ctrl+Alt+Shift+Back Arrow or Ctrl+Alt+Shift+Forward Arrow to create a
selection area from the current cursor position to the next event edge.

Time Selection bar
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Video Standards – NTSC, PAL, SECAM

It’s a big world, with more than one video standard. In fact, there are three standards –
NTSC (National Television Standards Committee), PAL (Phase Alternating Line), and
SECAM (Sequential Couleur Avec Memoire). Each of the standards differs in several
ways – most importantly in frames displayed per second and pixel resolution. These
standards exist for televisions, broadcast stations, VCR's, VHS tapes, DVD players, DVD
media, and camcorders.

Now, unless you’re recording something in North America to play in Europe or else-
where - or vice versa – then this is all something that you probably don’t need to worry
about. Nonetheless, it’s important to note that these formats are incompatible with each
other. For example, you will need a PAL VHS tape to play on a pal VCR through a PAL
TV.

Conversion from one format to another can be done. In fact, the Video Capture 
function of the Screenblast Movie Studio software will capture both NTSC and PAL 
formatted video.

NTSC is used in North and South America, Japan, and 30 other countries); PAL is used
in Europe, Australia, China, parts of Africa and the Middle East, as well as other coun-
tries; and SECAM is used in France, the former Soviet Union countries, and several
other countries in Africa and the Middle East.

Summary of video standards:

You’ll notice that SECAM uses the same pixel resolution and frame rate as PAL.
But these two differ in other technical ways – for example, SECAM transmits the color
information sequentially, while PAL does not. The two are not compatible with each
other and neither is compatible with NTSC.

Data Transfer Rates

Scan 
Lines

Data Rates/second 
in KB and MBFrame RatePixel

ResolutionNTSC Analog

625 Northand South America, Japan
and 30 other countries

29.97 frames
per second640 by 480NTSC Analog

625 Europe, Australia, China, Parts 
of Africa and the Middle East, 
as well as other countries.

25 frames
per second720 by 576PAL

625 France, the former Soviet Union
countries, and several countries 
in Africa and the Middle east.

25 frames
per second720 by 576SECAM
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This chapter will guide you

through the basics of 

creating a new multimedia

project—from capturing 

video and audio from various

analog and digital sources 

to selecting media from the

Screenblast.com online 

service.  Useful information on

dealing with file size limits and

tips on previewing your project

are also presented here. 

Starting a New Project
Your multimedia productions can be as simple or as complex as you’d like, including many video
clips, takes, voiceovers, music beds, and special effects. Organization of these components is
an important piece of the creation process. Organization in the Screenblast® Movie Studio™
software is handled by a small project file (.vf) that saves the relevant information about source
file locations, edits, cuts, insertion points, transitions, and special effects. This project file is not a
multimedia file, but is instead used to create the final file when your editing is finished.

� Starting a New Project

� Adding Media To Your Project 

� Getting Analog Video (VHS, Hi-8) 
Into Your Computer

� Capturing Video From Your 
Digital Video Camera

� Overcoming File Size Limits

� Getting Photographs From Your  
Scanner or Digital Camera

� Extracting Audio

� Previewing Media Files

� A Guide To Video and 
Audio Connections

� Adding Embedded Commands 
in Streaming Media
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Chapter 5: Creating a Project

The greatest advantage of working with projects is not the organizational benefits, but the fact
that you are working on and editing a project file, and not the original source files. When you
copy, cut, paste, trim, and otherwise edit your movie, the process is nondestructive. You can edit
without worrying about changing or corrupting your source files. This not only gives you a strong
sense of security, but it also gives you the freedom to experiment.

To Create a New Project File:
1. From the File menu, choose New Project. The New Project wizard displays. This wizard

assists you in choosing the appropriate properties for the project you’re creating.

2. Enter a project name and project path (the location where new media files will be
saved), and click the Next button.

3. To match the project properties of an existing media file, select the Make my project
settings match this media file check box, and enter (or browse to) the location of the
media file. The Screenblast Movie Studio software will automatically  set the project set-
tings to match the selected  media file. To specify your own settings, leave the check box
blank. When you are finished, click the Next button.

4. Choose the appropriate video output standard and click the Next button.

5. If you know the output media format you plan to use for your project, choose the appro-
priate option from the drop-down menu. If you don’t know, select the option I’m not sure
yet, I will choose later. You can always choose (or change) your output format once
you’re finished editing your project. Click the Next button.

6. Modify your width, height, and frame rate settings, if desired. Click the Finish button.

Note: The project settings you chose in the New Project wizard can be changed at any time while you are working on a project. To

change any of these settings, choose Project Properties from the File menu. These settings determine the overall quality of your

final video. By carefully setting up the properties at the beginning of your project, you can save a significant amount of time later. 

You can override these settings when you are ready to create the final movie, if you desire.

We recommend saving your project at regular intervals to avoid loss of work due to system fail-
ure or power outages. For more information, please see Saving Your Project on page 92.
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Getting Analog Video (VHS, Hi-8) Into Your Computer

Getting video from a digital camcorder into your computer via USB, USB 2.0, or iLINK®

connector (IEEE 1394) is a piece of cake -- but what about transferring those older analog
VHS or 8MM tapes? 

It is important to know that your computer needs to use video in a digital format. Since
VHS, S-VHS, 8MM, and even Hi-8 are all analog formats, they have to be converted, or
digitized, into a digital format so that you will be able to edit your video using the
Screenblast Movie Studio video editing software.

That may seem easier said than done. Analog camcorders and VCRs don’t have USB,
USB 2.0, or iLINK connector (IEEE 1394) ports. Instead they have analog connections like
S-Video or composite video RCA ports, which, in turn, computers typically don’t have.
And, while computers may have floppy drives, they don’t have VHS slots – so, how can
this be accomplished?

Relax – not all hope is lost. There are a couple of relatively easy ways that you can use to
get analog video into a digital format – and as a result, into the Screenblast Movie Studio
software -- which is why we’re all here in the first place.

One option is to get your hands on a digital camcorder (perhaps it’s time to upgrade or
maybe you will be able to find one from a friend or family member). Specifically, this 
camcorder must have both an analog input and a USB, USB 2.0, or iLINK (IEEE 1394),
output capabilities. You can then record the incoming analog video into the digital cam-
corder, which will be recording it in a digital format. Voila!  

From there, all you have to do is use the Screenblast Movie Studio software’s easy-to-use
and easy-to-understand Video Capture feature to capture the now digital video straight
from the digital camcorder. All of your recently digitized video is now ready to be edited in
the Screenblast Movie Studio software.

The second option is really a variation of the first. But, instead of digitizing the video
through a digital camcorder, the digitizing is done using a piece of hardware called a video
capture card or device which takes the analog video in one side and sends it to your
computer as digital video on the other side.

There are two types of video capture hardware –- internal cards and external devices. The
internal one is typically a PCI bus video capture card that you or a computer
technician installs inside the PC. The external one is a capture device that sits outside the
PC and connects to the computer via USB, USB 2.0, or iLINK connector (IEEE 1394). Just
make sure that your computer supports one of these.
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Getting Analog Video (VHS, Hi-8) Into Your Computer

In the end, both options will digitize the video and get it into the computer. The only thing that
you need to double-check is whether the digital camcorder that you are using for the digitizing or
the video capture card or device has the appropriate analog connections for whatever it is that
you are transferring your video from (VHS, Hi-8, etc.) Most analog camcorders or VCRs have
either composite video connectors (yellow, red and white cables) or they support S-Video. If you
have a choice between composite and S-video, you will get better results using the S-video con-
nector because it provides a better signal.

Which is better -- USB or iLINK connectors (IEEE 1394)?  Will the capture device 
provide the video resolution you need?

Video capture devices that use USB 1.1 (not USB 2.0) are not fast enough to capture full format
video files without dropping frames. iLINK (IEEE 1394) connections can offer thirty times the
bandwidth of the standard USB 1.1 connection...) 

To capture the full video without dropping frames or cutting corners on quality, it is always best
to use an iLINK (IEEE 1394) or even a USB 2.0 device. On the other hand if your aim is to 
capture small files for Internet streaming or for CD-ROM, (e.g. 352x288 pixels or smaller), a
USB 1.1 device may be a cost effective way to go.

Capturing Analog Video into Screenblast Movie Studio software 

Once you have your capture device installed, the basic process of capturing analog video into
your computer is pretty straightforward:

1. Plug the composite or S-Video Cables into the analog camcorder or VCR

2. If you’re using a camcorder, put it in VCR mode

3. Plug the other end of the component or S-Video cable into the analog video ports of the
capture card or device

4. If it’s an external capture card or device, attach it to the iLINK (IEEE 1394) or USB port
on your computer

5. Open the Capture window from the File menu 

6. Capture the video by playing it from the camcorder or VCR while recording it usingthe
Capture window.

S-Video Connection  Composite Video Connection (yellow)
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Adding Media to Your Project
You’re ready to begin auditioning media files and adding them to your project. The Screenblast
Movie Studio software can work with many different types of media files, including.

You can use the Media Pool tab, found in the multifunction area in the lower left corner of the
main application window, to add media to your project using any of the following methods:

� Find and preview existing files on your drives.

� Begin capturing new video from your video camera.

� Get photographs from your scanner or digital camera.

� Extract audio from a CD.

� Download media from the Web.

Each of these methods is explained in more detail in the following sections. You can gather
selected files for inclusion in your project before you know exactly how you want to arrange
them. If you know you want to use a media file in your project, but you’re not ready to start plac-
ing files on the timeline, you can add the files to the Media Pool and easily locate them later.

• CD Audio (.cda)

• Portable Network Graphic (.png)

• GIF (.gif)

• QuickTime (.mov, .qt, .dv, .gif)

• Joint Photographic Experts 
Group (.jpg, .jpeg)

• Macintosh AIFF (.aif, .aiff, .snd)

• Sony Perfect Clarity Audio
(.pca)

• MP3 Audio (.mp3)

• Sony Wave64 (.w64)

• MPEG (.mp2, .mpg, .mpeg,

.m1v, .m1a)

• TARGA (.tga, .targa)

• MPEG 1 (.mp2, .mp3)

• Video for Windows (.avi)

• OggVorbis (.ogg)

• Wave (Microsoft) (.wav)

• Photoshop (.psd)

• Windows Bitmap (.bmp, .dib)

• Sony MicroMV (.mmv)
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This way, all of your media files will be located in one place when you’re ready to start arranging
them for your final composition.

Note: Screenblast Movie Studio software now supports direct connection over the iLINK connector with the Sony DSR-DU1

DVCAM Video Disk Unit via the SBP2 protocol. This unit records DV files directly to hard disk. Using the SBP2 protocol, the DV

files stored on the DSR-DU1 can be selected on a file basis from the Screenblast Movie Studio application, and then uploaded to

your computer hard drive at up to two times faster than real-time.

Finding Existing Media File
1. Click the Import Media button ( ) on the Media Pool tab. The Open dialog displays.

2. Select a media file and click the Open button. The file is added to the Media Pool tab.

3. To preview the file, click once to select it, and then click the Start Preview button ( ). If
the file includes video, the video portion will display in the Video preview area in the
lower  right corner of the main application window. Use the Stop Preview button ( )  to
stop the preview at any time.

4. To add more files, repeat steps 1–3 above.

Finding Existing Files Using the Explorer Tab
Another method for locating existing media files uses the Screenblast Movie Studio software
Explorer tab, also located in the multifunction area, which operates in the same way as the
Windows Explorer, with which you are probably already familiar. The advantage to using the
Explorer tab is that it allows you to easily “audition” the media files prior to adding them to your
project by using the Preview option.

The process for locating media works the same as finding files in the Windows Explorer: use the
left pane to expand and collapse the drive and folders you want to search, and the right pane to
select media files contained in the selected drive or folder to preview. Once you have located a
file, click once to select it, and then click the Start Preview button ( ) to play the file. If the file
includes video, the video portion will display in the Video preview area in the lower right corner
of the main application window. Use the Stop Preview button ( ) to stop the preview at any
time.
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� To add a file to the Media Pool, follow these steps:

To add a file to the Media Pool, follow these steps:

1. Use the Screenblast Movie Studio software Explorer tab to locate a file.

Note: The Screenblast Movie Studio software is preset to display only supported file types. However, you may change 

the  list view to display all files within a selected drive or folder. To change the Explorer view, click the 

View button ( )  on the Explorer toolbar.

2. Right-click the file to display the shortcut menu.

3. On the shortcut menu, choose the Add to Media Pool option. The file displays in the
Media Pool tab.

Capturing Video from Your Video Camera
You can use the Screenblast Video Capture application (installed with the Screenblast Movie
Studio software) to capture new video clips from your video camera if you have a video capture
card installed (for more information on using video capture cards with the Screenblast Movie
Studio software, see Configuring Your System for Video Capture on page 16).

� To capture video from your video camera, follow these steps:

1. If you have not already done so, connect your video camera to your video capture card
using the cable provided with the card.

2. In the Media Pool tab, click the Capture Video button ( ) The Screenblast Video
Capture application starts.

Note: If your video camera is properly connected, the Video Preview window in the 

center of the application area should display Device Connected.

3. Capture your video. For information on how to capture video with Screenblast Video
Capture, click the Help menu within the Video Capture application, and choose Contents
and Index. The Video Capture online help file displays.

4. Once you have captured your video, the file(s) are added to the Media Pool tab.
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Overcoming File Size Limits

If you work with video clips that have extraordinarily large file sizes then you may sometimes

find yourself running into file size limits. These problems will probably most likely occur with AVI

files since AVI is an uncompressed video file format.

Why is this?  Well, there are two limits to be aware of -- limits imposed by your computer’s oper-

ating system as well as limits on the size of the AVI file itself...

Limits Based on Operating System / Disk Formats

There are limits to the size of files a computer system can import or create, depending on the

operating system and the particular version of Windows disk formatting system used:

Under Windows 98, 98se, and ME, your drives can be formatted as FAT (File Allocation Table)

or FAT32. The largest a single file can be on these operating systems is 4 GB. You can reach 4

GB rather quickly with digital video renders. For instance, NTSC DV AVI files take up about 3.5

MB per second of video.

Under Windows 2000 and Windows XP the operator has the ability to format their drives as FAT,

FAT32, or NTFS (New Technology File System), and they are most commonly formatted as

NTFS. NTFS drives really have no file size limitation other than the overall space of the hard

drive.

� The theoretical maximum limit for drive partition size using NTFS is 16 Exabytes –

which roughly translates into the space needed for 4 billion feature-length movies –

not something you’re likely to need in the next couple of years.

It is important to know that if you use the FAT32 disk format, then the Video Capture feature

in the Screenblast Movie Studio software will get around the 4GB limitation by automatically 

creating a new file every time you get close to this limit. This handy feature makes it possible to

capture more than 20 minutes of video into your computer at one time. You can edit these clips

together on the timeline to create a long project.

Additionally, the Screenblast Movie Studio software also segments the files during the rendering

process. If you use the Make Movie Wizard to write your movie to a DV tape, your project will be

rendered as segmented clips but will print to tape seamlessly.

Of course, if you have Windows 2000 or Windows XP with a NTFS-formatted drive, then you can

capture and create digital video projects without regard to file size limits.
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Getting Photographs from Your Scanner Or Digital Camera
If you have a scanner or digital camera, you can use the Media Pool tab to get photos from the
device. To do so, follow these steps:

1. On the Media Pool tab, click the Get Photo button ( ) The Select Camera/Scanner
dialog displays.

2. Choose your camera or scanner from the drop-down list and click the OK button. The
Screenblast Movie Studio software starts your scanner or camera software.

3. Use the Scanner dialog to scan your photo, and close the dialog when you’re finished.
The photo is added to the Media Pool tab.

Extracting Audio 
You can use the Media Pool tab to extract audio from other media such as a CD. To do so, 
follow these steps:

1. On the Media Pool tab, click the Extract Audio from CD button ( ) The Extract Audio
from CD dialog displays.

2. To extract a single track, click once on a track to select it. To select multiple consecutive
files, click the first track, hold down the Shift key on your keyboard, and click the last
track. To select multiple non-consecutive files, click the first track, hold down the Ctrl key
on your keyboard, and click the files you want to extract. When you have selected all of
the files you want to extract, click the OK button. The Audio File Name dialog displays

3. Enter a name for the audio file and click the Save button. The audio file is extracted from
the CD and added to the Media Pool tab. If you chose to extract more than one track,
repeat this step for each selected track.

Previewing Media Files
Once you have added files to the Media Pool, you can preview them anytime before adding
them to the timeline. To do so, simply click once on the file to select it, and then click the Start
Preview button ( ) To stop the preview, click the Stop Preview button ( ).

You can enable automatic previewing of the selected file by clicking the Auto Preview button
( ). When this option is enabled, any file you select in the Media Pool is automatically pre-
viewed. To stop the preview, click the Stop Preview button. To disable this option, click the Auto
Preview button again.
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Recording Audio
You can also use the Screenblast Movie Studio program to record your own audio (voiceovers,
music, narration, etc.) for inclusion in your project. You can record video into a track or a single
event on a track. You will need an input device (such as a microphone) attached to your PC
sound card for recording purposes

Recording into a Track
If you have a scanner or digital camera, you can use the Media Pool tab to get photos from the
device. To do so, follow these steps:

1. Click on the timeline to place your cursor where you want the recording to begin. The
incoming audio will be inserted into the timeline at this point on the selected track.

2. To start recording, click the Record button ( ).

3. To stop recording, click the Record button again, or click the Stop button ( ). The
Recorded Files dialog displays with the location and file name for the recording.

4. To change the file name, click the Rename button, type the new file name, and press
Enter on your keyboard.

5. To delete the recording, click the Delete button.

6. When you are finished, click the Done button. The recording is positioned in the timeline 
after the cursor, and the recorded event appears in the Media Pool tab. The original file
is stored in the default location for the project.

Recording into an Event
When you choose to record into an event, you replace the existing audio in the event with the
audio from your recording. However, the original audio is saved in a take that you can select
later if you decide not to use the new audio.

1. Click on the event and place your cursor where you want recording to begin.

2. To start recording, click the Record button ( ).

3. To stop recording, click the Record button again, or click the Stop button ( ). The
Recorded Files dialog displays with the location and file name for the recording.

4. To change the file name, click the Rename button, type the new file name, and press
Enter on your keyboard.
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5. To delete the recording, click the Delete button.

6. Use the Scanner dialog to scan your photo, and close the dialog when you’re finished.
The photo is added to the Media Pool tab.
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The World of Video and Audio Connectors: A Guide 

BNC

The connector type that you are least likely to see on consumer video devices is the BNC con-
nector. BNC connectors are primarily used in professional video applications and some data
communications equipment. BNC connectors have an outer collar that twists along a spiral
groove to firmly lock the connector into the jack.

If you’ve ever looked at the back of a TV, DVD player, VCR, or camcorder, then you’ve probably
come across a bewildering variety of video and audio connection types. Why are there so many,
what are they, and how can you tell them apart?  More importantly, do I need any of them to get
my video into my computer so that I can start editing my stuff?  We have the answers...

RCA

The most common type of audio/video connector is the RCA. You may sometimes hear these
called “phono” plugs because originally they were used to connect phonograph players to home
stereo systems. RCA connectors are usually colored yellow, red, and white and are used for
everything from DVD players and VCRs to video game systems.

RCA Plug RCA Cables RCA Video Audio Connectors

BNC Plug BNC Jack
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3.5mm Mini-Plug

3.5mm "Mini Plugs" are usually used for headphone connectors on computers and small video
cameras. They may also be used to bring audio into and/or out from such things as computers
and minidisk recorders.

3.5mm AV connector

Some MiniDV digital video cameras use a special 3.5mm connector to combine analog video
and audio signals, which are then broken out as separate RCA connections at the other end of
the cable. This special 3.5mm AV plug can be used to make a copy to or from a home VHS
videocassette recorder.

Phone Plug

This is the standard connector for headphones, microphones and, yes, musical instruments like
electric guitars. The plugs come in two types (stereo and mono) and three sizes: 1/4" (6.35 mm),
1/8" (3.5 mm or mini) and 3/32" (2.5 mm or submini).

3.5mm Plug 3.5mm Headphone Jack 3.5mm Mini-Mic Jack

3.5mm AV connector 3.5mm AV mini-jack

1/4” Phone plug 3.5mm mini-plug 2.5mm submini-plug
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Coaxial -- F-Type and RF Connectors

You have most likely used the Coaxial (or “Coax”) cable many times in your life, and there are
two types: the F-Type (threaded) and the RF (unthreaded) connector. F-Type connectors are
usually what your cable or TV antenna uses.

RF (Radio Frequency) connectors are one of the oldest types of coaxial connectors and are
used to connect TV monitors to antennas or videocassette recorders. Keep in mind, however,
that while Coax cables provide a good quality connection, line-in connectors such as RCA
Cables or Component cables provide much better picture and sound quality.

i.LINK® / IEEE 1394 / FireWire™

The cable that is known by many different names, the i.LINK, IEEE 1394 or FireWire cable is a
very fast (up to 400 megabits per second), two-way digital connection that allows data transfer
between computers and peripherals like digital cameras and digital camcorders. If your comput-
er and digital camera or digital camcorder supports it, then the i.LINK connector is the ideal con-
nection method. It’s one of the few connections fast enough to transfer full-motion video. Most
consumer video equipment uses 4-pin i.LINK ports and connectors, but some peripherals use a
6-pin i.LINK connector. The two types of i.Link connectors are shown above.

Coaxial Cable Coaxial Jack

4-pin Firewire 4-pin Firewire Jack 6-pin Firewire 6-pin Firewire
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USB (Universal Serial Bus)

If your computer or digital camera or digital camcorder doesn’t support i.LINK (IEEE 1394,) then
most likely your computer and digital imaging devices will have USB connections. USB cables are
commonly used to attach digital still cameras and other peripherals to a computer. There 
are two types of USB connectors – the “A” type is the larger one, while the “B” type is a “mini-USB”
which is used where space is at a premium, such as on small devices like MP3 players or cameras.

Component Video Connection

Component video is the heavyweight champion among the quality connection methods, providing the
best quality transmission of analog video from one device to another. Component video uses three
different cables to carry each of the color components of the video signal on a separate wire. The
RCA connectors are usually color-coded and attached together to make one three-headed cable.

Composite Video Connection

Composite video combines all of the Luminance (brightness) and Chrominance (color)signals on
a signal wire. This makes for a simple one-wire connection, but it sacrifices quality. Composite
video on consumer video devices is usually connected with a yellow color-coded RCA plug.

“A” Type USB plug “A” Type USB Jack Mini-USB Plug

Component Video Cables Component Video Jack

Composite Video Cables Composite Video Jack
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Editing Events on the Timeline
The Screenblast® Movie Studio™ software allows you to perform simple event-level editing. This
editing includes common copying, pasting, and deleting operations. However, these editing 
procedures and how they are implemented depend on what type of selection is made: event
only, time only, or event and time.

Copying Events
The Screenblast Movie Studio software allows you to copy events, or portions of events, to the
Clipboard and paste them into your project. You may copy a single event or multiple events.
Copying preserves the original event information, edits, and other modifications.

� To Copy Events:

1. Click on the events to select them. For more information, see Selecting Multiple Events
on page 41.

2. Select your time range, if applicable.

� Editing Events: Copy, Paste, 
Cut, Split, Trim, and More

� Previewing Your Project

� Using Screenblast ACID 4.0 
and Movie Studio software 
Together

� Adding Transitions

� Crossfading 

� Using Video Time Stretch

� Adding Audio and Video Effects 

� Making Video Slide Shows 
with Pan and Crop

� Using the Chroma Key Effect

A ssembling Events on the timeline
is a good first step in creating

your project. But to make it really
interesting and give your project a
professional look, the Screenblast
Movie Studio application provides
a lot of powerful editing functions,
exciting transitions, and amazing 
special effects. This chapter shows
how to use these features to finish off
your project with some real pizzazz. 
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3. Copy the event to the Clipboard by doing one of the following:

� Press the Ctrl+C keys.

� From the Edit menu, choose Copy.

Copy Time Selection
Events within the time selection and across all tracks are reproduced and placed on the
Clipboard. Time information is also placed on the Clipboard. You can make a time selection first
and then select events within that time selection to further modify a selection.

events before copy Clipboard Contents Events after copy

The original events
are not affected and
do not change.

Cutting Events
Cutting events removes them from their respective tracks, but places the cut information (events
and time) on the Clipboard. Once on the Clipboard, you may paste the information into your proj-
ect.

� To Cut an Event:

1. Click on the event to be cut to select it or select a time range.

2. Cut the event to the Clipboard by doing one of the following:

� Press the Ctrl+X keys.

� From the Edit menu, choose Cut.
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Pasting Events
Once information is copied to the Clipboard, you may choose a variety of ways to paste the
Clipboard items. The Screenblast Movie Studio software always pastes from the insertion point’s
position along the timeline.

� To paste events from the Clipboard:

1. Move the cursor to the desired timeline location.

2. Click either the track number or within the track where you want to paste the event. This
track is the focus track; there can be only one focus track at a time.

3. Paste the event into the track by doing one of the following:

� Press the Ctrl+V keys.

� From the Edit menu, choose Paste.

Clipboard events are pasted at the cursor position on the track. Existing track events can be
overlapped with newly pasted information.

Duplicating Events
Duplicating is a combination of a copy and paste in one action.

� To duplicate an event:

1. Hold the Ctrl key on your keyboard.

2. Drag the event you want to duplicate to the place where you want the new event to be
positioned.

The process is like moving the event to a new position while leaving a copy behind.

Before Pasting

After Pasting
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Trimming Events

� To Edge-Trim a Video Event:

1. Insert an event into the timeline.

2. Move the cursor over the edge of the event. The cursor changes when properly posi-
tioned.

3. Drag the edge of the event to trim.

During the trimming process, the last
thumbnail image on the event shows
the last frame in the event, allowing
you to edit events very accurately.
Events cannot be trimmed back from
their starting point towards an earlier
position on the timeline unless the
beginning has been previously
trimmed. However, you can extend a
video event beyond its end, in the
process making it longer. When you do
this, the event is looped or repeated.
A notch appears at the point in the event where the video ends and the thumbnails begin
repeating. Since a multimedia file often has both a video and an audio component, both events
are trimmed as a group (unless you ungroup them).

Trimming events removes all media outside the time selection from their respective tracks.
However, the removed information is not placed on the Clipboard. Trimming is different from 
cutting in that the events within the time selection are preserved.

� To Trim an Event Based on a Time Selection:

1. Select a time range.

2. Press the Ctrl+T key or, from the Edit menu, choose Trim Event.

Events outside the time selection are removed from the project. However, the time information
(space) between events is not removed.
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Splitting Events
The Screenblast Movie Studio software allows you to create multiple, independently functioning
events from a single event by splitting it. Splitting creates a new ending point for the original
event and creates a starting point for the newly created event. Splitting an event does not alter
the original media. The original media file’s information is there, but omitted for playback, based
on where the event’s starting or ending point occurs on the timeline.

� To Split an Event:

1. Select the event to be split.

2. Place the cursor at the timeline position where you want
the split to occur.

3. Split the event(s) by doing one of the following:

� Press the S key.

� From the Edit menu, choose Split Event.

� Click the Split Event button ( ) on the main toolbar.

To split multiple events, use the Ctrl key, the Shift key, or the Selection Edit Tool (accessible from
the Edit menu by choosing Editing Tool, followed by Selection) to select the events. For more
information, see Selecting Multiple Events on page 41.

Note: Splitting Events is a good way to remove a section of unwanted media.

Events before trim Clipboard contents Events after trim

Trimmed information
is not placed on the

clipboard.

Original event

Split position

Two events

Separated events
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Shifting the Contents of an Event
Events in the Screenblast Movie Studio software are defined by their duration and not by the
actual content. Typically, an event is a portion of a larger source media file saved somewhere on
your computer. For example, you could have an event that contains only ten seconds (e.g. from
00:40 to 00:50) of a one minute video file. The actual footage it contains can be modified in a
number of ways, including shifting it to encompass, for example, from 00:20 to 00:30 in the 
original video file. To shift the contents of an event, press the Alt key while dragging left or right
on a video event.

Deleting Events
Deleting events removes all events within the time selection from their respective tracks.
However, the removed information is not placed on the Clipboard.

� To Delete An Event:

1. Click on the event to be deleted to select it, or select a time range.

2. Delete the event(s) by doing one of the following:

� Press the Delete key.

� From the Edit menu, choose Delete.

The original media file

The event trimmed from the original media file

The event on the timeline

The original media file
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Delete Time Selection
Events within the time selection are removed from the project. However, the time information
(space) between events is not removed. This space would be removed if you have ripple editing
mode activated. For more information on ripple editing, please refer to the Screenblast Movie
Studio software Help file (accessible from the Help menu by choosing Contents and Index.)

Undoing and Redoing Actions
The Screenblast Movie Studio software gives you practically unlimited undo and redo functionali-
ty while working on your project, even to the extent of being able to undo changes made before
the last time a project was saved (but not closed). While you are working with a project, the
Screenblast Movie Studio software creates an undo history of the changes that you have per-
formed. Each time you undo something, that change is placed in the redo history. When you
close the project or exit the Screenblast Movie Studio software, both the undo and redo histories
are cleared.

Undo Command
Pressing the Ctrl+Z keys on your keyboard or clicking the Undo button ( ) on the main toolbar
will undo the last edit performed. Repeatedly using the keyboard command or toolbar button will
continue undoing edits in reverse order, from most recent to oldest.

Events before trim Clipboard contents Events after trim

Delete information is
not placed on the

clipboard.
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Using the Screenblast Movie Studio Software 
with the Screenblast ACID 4.0 Software

Even the best-looking video isn’t very exciting without a great soundtrack.
Screenblast Movie Studio software has tracks for editing and synchronizing
music, dialogue, and sound effects, however, to go the extra mile you will
need really specialized tools to create and manipulate those music and
audio tracks. Fortunately, there is an awesome Screenblast tool for doing
amazing things with audio and music – it’s called Screenblast ACID 4.0
music creativity software.

The Screenblast ACID 4.0 program lets you work with music loops to easily
create professional-sounding music tracks – even if you’ve never played an
instrument before in your life! Using the two pieces of software together
couldn’t be easier – in fact, you can automatically open any of your audio
tracks directly into the Screenblast ACID 4.0 program

Here’s how:

1. Make sure you’ve installed the Screenblast ACID 4.0 software on
your computer.

2. In the Screenblast Movie Studio application, open Preferences in
the Options menu and click on the Audio tab.
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3. Use the Browse button to locate the Screenblast ACID 4.0 appli-
cation and select it as the default audio editor.

4. Open a Screenblast Movie Studio project 

5. Select the event you want to open in the Screenblast ACID 4.0
application (click on the event in the timeline).

6. From the Tools menu in the Screenblast Movie Studio software,
click on Audio and select either Open in Audio Editor or Open
Copy in Audio Editor.

Using the Screenblast Movie Studio Software 
with the Screenblast ACID 4.0 Software
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7. The Screenblast ACID 4.0 music editing software will automatically open and
will already have a track with the name of the event.

8. Now you can use the audio tools in the Screenblast ACID 4.0 program to work
with your audio file.

Taking Audio Back Into the Screenblast Movie Studio Application

After you’ve worked with the audio file in the Screenblast ACID 4.0 application, save any
changes you make and import the media file into your movie in the Screenblast Movie
Studio software to integrate the changes.

Of course, you don’t have to start with the Screenblast Movie Studio video editing soft-
ware -- you can also simply use the Screenblast ACID 4.0 program to create your music
and audio elements, then save them using the Render As command in the File menu.
This lets you create your audio track in any of the supported audio file types recog-
nized.

Screenblast Movie Studio video editing software and Screenblast ACID 4.0 music edit-
ing software make the perfect pair to polish your tunes and sounds for your movie’s
sound track – try it!

� To Undo a Series of Edits:

1. Click on the arrow to the right of the Undo button ( ) to view a history of your edits.

2. From the drop-down list, use the mouse to point to the edit that you want to undo. The
top listed item is the most recent edit. As you drag the mouse down the list, notice that
items are selected automatically. If you want to undo a specific edit that appears farther
down the list, all subsequent edits will also be undone as well. Click outside the drop-
down list to cancel undo.

3. Click the last item you want undone, and all selected edits are undone. The Screenblast
Movie Studio program will restore your project to the state prior to those edits.

Note: From the Edit menu choose Undo All to undo all edits in the history.

All edits will be undone and added to the redo history.
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� Redo Command

Pressing the Ctrl+Shift+Z keys or the Redo button ( ) on the main toolbar will redo the last
undo performed. Repeatedly using the keyboard command or Toolbar button will continue redo-
ing in reverse order, from most recent to oldest. In addition, you may redo the last edit by choos-
ing Redo from the Edit menu.

� Clearing the Undo History

You may clear the undo history without closing your project or exiting the Screenblast Movie
Studio program. To clear the undo history:

1. From the Edit menu, choose Clear Undo History. A confirmation dialog appears.

2. Click Yes to clear the edit histories. Or, click No to cancel and keep the undo history.

Previewing Your Project
Any time in the creation process, you can preview your project to see how the final product
might look. This also allows you to find any areas you might like to adjust or problems you’ll want
to correct. The Screenblast Movie Studio program has two previewing options:

� Preview your project in the Video Preview area on the lower right corner of the main
workspace.

� Preview your project in an external media player.
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Previewing in the Video Preview
1. Position the cursor in the timeline where you want the preview to begin. If you want to

start at the beginning of the project, click the Go To Start button on the transport bar.

2. If desired, adjust the size of the Video Preview area by dragging the top and side bor-
ders.

3. To start the preview, click the Play button ( ) on the transport bar.

4. To stop the preview at any time, click the Stop button ( ) on the transport bar.

Previewing in an External Media Player
1. From the Tools menu, choose Preview in External Player. The Preview in Player dialog

displays.

2. From the Preview as drop-down list, choose the file type you want to create.

3. Choose a setting from the Template drop-down list to specify the settings that will be
used to save your file.

Note: The settings for the selected template are displayed in the Description box.

If you want more control, click the Custom button to create your own templates.

(The Custom button is not available for streaming formats.)

4. Select the Render Loop Region Only check box if you only want to render a portion of
your project. If the check box is cleared, the entire project will be rendered to a new file.

5. Select the Stretch Video to Fill Output Frame check box if you want the Screenblast
Movie Studio software to reformat your video so it fills the output frame size listed in the
Description box. When the check box is cleared, the Screenblast Movie Studio software
maintains the current aspect ratio and adds black borders to fill the extra frame area
(called a “letterbox”). This option is useful when the desired output format does not
match the frame aspect ratio of your project.

6. Click the OK button. The Screenblast Movie Studio software renders the file using the
settings you specified, and when rendering is complete, the default player for the file
type is started.

Note: Rendering your entire project to preview in an external media player may take a while. If you are mainly interested to see

how a particular area or transition looks, it may be best to preview the material in the video preview box or choose Render Loop

Region Only to save time while previewing.
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Adding Transitions
Transitions occur between two video events and are an entertaining and interesting method of
switching between scenes or shots. Too many transitions in a single production, however, can
distract from your movie. Most professional productions on television or on the “big screen”
use only two types of transitions. The first is a simple cut, where one scene immediately cuts
to the other without delay or effects. The second is a fade, otherwise known as a crossfade or
a dissolve.

Cuts
A cut is actually not a transition. Instead, the last frame from an event is immediately followed by
the first frame of the next event. This is what happens with two adjacent events on the
Screenblast Movie Studio software timeline, either in the same track or in different tracks. This
can also happen when an event is punched into another.

Cuts can be converted to a transition effect by dragging a transition to the cut position. This will
only work if the two events involved in the cut have enough media trimmed back (from the end of
event one and the beginning of event two) to be used in the transition effect.

Crossfading Events
The Screenblast Movie Studio program allows you to crossfade between two events (audio and
video) on the same track. A crossfade occurs when one event that is ending overlaps with a new
event on the same track. The first or outgoing event in the crossfade will be fading out during the
overlap, while the second or incoming event will be fading up during the overlap. Lines appear
on the event at the crossfade point to indicate how and when the event’s volume or transparency
is being affected.

Adjacent events Events on different tracks Punch-in events
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Automatic Crossfades
The automatic crossfade feature turns the overlapping portions of two events (audio or video)
into a smooth crossfade. To enable or disable automatic crossfades, choose the Automatic
Crossfade option from the Options menu, or press the X key on your keyboard. The crossfade
“x” will automatically adjust itself as you move one event over another as long as one event’s
edge is crossing the other event’s edge. In the case where edges do not cross (one event is
wholly contained in another), the shorter event will be placed on top of the longer event.

Changing Crossfade Curves
You can set the crossfade curve(s) that the Screenblast Movie Studio software uses to fade in
and out between two events. The crossfade curves determine how the Screenblast Movie Studio
software raises and lowers the events’ volumes over time.

� To Change The Crossfade Curve:

1. Right-click anywhere in the crossfade region to display a shortcut menu.

2. From the shortcut menu, choose Fade Type (for audio events) or Crossfade (for video
events) to display the fade/crossfade types submenu.

3 Click the desired fade or crossfade type to set it.

Fade out 
volume lin

Fade in vol-
ume line

Events before crossfade

Drag the events to overlap

Events after crossfade
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Transition Effects
Placing video events in the order you want them to play is just the beginning of what you can
accomplish with the Screenblast Movie Studio application. To make things a lot more interesting,
you can choose from a wide variety of transition effects to add excitement when moving from
one video event to the next. Dissolves, wipes, squeezes, slides, zooms and many more are all
available in the built-in transition library. Try them and see how much more fun your project is
when you spice it up with some well placed transitions. This section explains how to do just that.

� To Add a Transition Effect:

1. Insert a video event onto the timeline or on a track.

2. Insert another event so that it overlaps the first to create an automatic crossfade.

3. Click on the Transition tab in the multifunction area.

4. Select the type of transition you want to use from the left side of the window.

5. From the Preset area on the right, select the specific preset you want to use. Watch the
animation of the preset to preview the effect.

6. Drag the preset to the timeline area where the two video events overlap (the crossfade
area).

The duration of a transition is automatically determined by the amount of overlap between the
two events. As with other events in the Screenblast Movie Studio program, dragging the edges
in and out can control the precise duration of a transition.
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Transitions to and from Black
Transitions can also be added to the beginning or ending of any event without transitioning into
another event. The effect then acts as a transition between the video event and black. Instead of
a simple fade-to-black, this allows you to transition-to-black using any of the transition effects.
For example, when transitioning from a video event to new title or video overlay, try using a clock
wipe, squeeze or zoom to provide a more exciting transition to black for the video event.

This feature can be an especially interesting technique when used in combinations with overlay
titles. To add a transition effect to the beginning or ending of an event, drag the transition from
the Transitions tab to the edge of the event. The details of the transition can be modified on the
Transition dialog that displays when you drop the transition on the event.

Previewing a Transition
The easiest way to preview a transition is directly from the Transition dialog after you drop the
transition. You can then adjust the transition while it is playing, quickly making your changes in
real-time.

� To Preview a Transition:

1. On the Transition dialog, click the Play button ( ). The preview plays in the Video
Preview area at the bottom of the main workspace. You may need to drag the Transition
dialog out of the way to view the Video Preview area.

2. Click the Stop button ( ) at any time to stop the preview.

Modifying a Transition
All of the transitions in the Screenblast Movie Studio program include preset settings to create a
perfect transition. Most transitions are highly customizable with many attributes that can be
changed.

� To Modify a Transition:

1. Click the Transition Properties button ( ) on the event. The Transition dialog displays.

2. Change the parameters as desired. Changes are updated in real-time in the Video
Preview area.

Each transition has individual controls and variables, such as direction, color, feathering, orienta-
tion, motion, border size and many others. The controls and variables are tailored to the type of
transition, and allow you customize details of the transition to suit your creative needs.
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After modifying a transition, it is possible to save the changes as a preset for use at a later time.
You can choose default and custom presets from the Preset drop-down list.

� To Save a Preset:

1. Click the name in the Preset drop-down list.

2. Enter a name for the new preset.

3. Click the Save Preset button ( )

Any additional changes can be instantly saved to the custom preset by clicking the Save Preset
button. Changes cannot be saved to the (Default) preset.

Using Video Time-Stretch to Make Slow or Quick Motion
Technically referred to as Time-Stretch (time compression and expansion), one of the most 
popular – and entertaining -- video effects is the one where time is sped up or slowed down.
This effect can often be used for comedic effect or to emphasize a dramatic moment.
Screenblast Movie Studio video editing software has a quick and easy way to let you
squeeze or expand time on a video clip.

Try it!  Speed up those sports videos to make it look like you’re running in record time!  Or, you
can speed those old home movies to make them look like an off-speed newsreel from the
1920’s -- especially if you use the Very Old Film or Circa 1908 Video Effects.

Here’s how:

Once you’ve placed a video clip (referred to as an event) into the timeline, you can make the
total event take up more time or less time for the same action by simply holding the Control (or
Ctrl) key on the keyboard while you drag the edge of the event. When you release the event,
you’ve automatically changed the speed of the video!  Note that as you change the length of an
audio event, its pitch goes up or down along with the speed.

Hold down the Ctrl key while using the mouse to drag the right or left edge of an event.
Notice the cursor is now displayed as:

As you drag the edge of the event, the software displays a wavy line between video frames to
show you that the event has been stretched.
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Stretching the event will cause it play in slow motion. If you drag the edge of the event and
squeeze it in to make it smaller, it will cause the video to speed up and play in fast motion.

You can also go one step further by creating video clips with gradual changes in the speed. To
do this, split the event into several smaller sections and apply Time-Stretch with either progres-
sively slower or faster action for each of these separate events. Or, you can jump directly into
slow motion for part of the scene and then right back to regular speed for the rest of it.

Video Time Stretch is one of the most powerful Hollywood-style special effects and is also one
of the easiest to do. Whatever the effect, Screenblast Movie Studio video editing software gives
you the tools to achieve your most creative visions.

Using the Red-Eye Reduction Feature
Screenblast Movie Studio now features a useful tool for removing any "red eye" that you may
have in photos. To use this feature, right-click on the photo in the timeline and then from the
menu select Red Eye Reduction. A simple tool will pop-up that will allow you to select the red
eye areas that you want to change. You can click on the + or - bars to zoom into or out of the
photo for extra control.

To undo a recent change made using the Red-Eye Reduction Feature, click on the Edit Menu,
then click on Undo Red Eye Reduction Edit.
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Adding Effects
The Screenblast Movie Studio software includes a variety of audio and video effects that you
can apply to make your project even more interesting. You can apply an effect to an individual
audio track, all audio tracks, an individual video event, or the entire video output. These options
are explained in the following sections.

Adding Effects (FX) to an Audio Track
1. Select the track to which you want to add effects.

2. Click the Audio Track FX button ( ) on the track to which you want to add effects. The
Audio Plug-In dialog displays.

3. Click on the Edit Chain button. The Plug-In Chooser dialog box displays.

4. Select each plug-in you want to add and click on the Add button, or browse to an FX
package. The plug-ins appear at the bottom of the window in the order in which you
added them.

5. To reorder the plug-ins within the chain, drag a plug-in button to a new location, or click-
the Shift Plug-In Left ( ) or Shift Plug-In Right ( ) buttons.

6. Once you have added all of the plug-ins and specified the plug-in chain order, click on
the OK button. The Audio Plug-In dialog is displayed.

7. Adjust the settings for each FX as desired. Click on the Help button within the FX win-
dow for information on specifying the settings

Adding Effects (FX) to All Audio Tracks
To add Effects to the combined output
of all tracks, use the Audio Output FX
button located on the Audio Mixer
Control.

This will apply the effects to the com-
bined total audio output of all audio
tracks rather than any single individ-
ual track. Control ofthe Effects Chain
is that same as outlined above.

Audio Output FX for the main mixer output
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Adding Effects (FX) to a Video Event or the Entire Video Output 
1. Select the Video FX tab.

2. Select an effect from the list on the left side of the tab. The thumbnail images on the
right side of the tab represent each of the existing presets for the selected effect. Hover
your cursor over a preset to see an animated example.

3. After you've found the preset that you want to use, drag it to the position where want to
use it in your project:

� Drag a preset to a single event to affect only that event.

� Select multiple events and drop a preset on any selected event to apply it to all
selected events.

� Drag a preset to the Video window to apply it to all events as Video Output FX.

4. The Screenblast Movie Studio software displays a green FX button ( ) on the event to
show you which events have effects applied (this button appears as white if there is no
effect applied). Click this button to change effect settings. To change settings on a Video
Output FX, click the Video Output FX button ( ) on the Video Preview area.
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Deleting Audio or Video Effects (FX)
Removing an audio or video effect is an easy process. Follow the steps below for each case.

Deleting Effects (FX) From an Audio Track 
1. Click the Audio Track FX button ( ) on the track. The Audio Plug-In window displays.

2. Select the effect you want to remove.

3. Click the Remove Selected Plug-In button ( ). The plug-in is removed.

4. Click the Close button.

Deleting Effects (FX) from All Audio Tracks
1. Click the Audio Output FX button ( ) on the Audio Mixer control. The Audio Plug-In

window displays.

2. Select the effect you want to remove.

3. Click the Remove Selected Plug-In button ( ). The plug-in is removed.

4. Click the Close button.

Deleting Effects (FX) from a Video Event
1. Click the green FX button ( ) on the video event. The Video Event Properties window

displays.

2. Click the Remove Selected Plug-In button ( ). The plug-in is removed.

3. Click the Close button.

Deleting Effects (FX) from All Video Output
1. Click the Video Output FX button ( ) on the video event. The Video Output FX win-

dow displays.

2. Click the Remove Selected Plug-In button ( ) The plug-in is removed.

3. Click the Close button
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Making Great Slideshows with Pan/Crop FX
One of the outstanding features of the Screenblast Movie Studio video editing software is that it
can help you turn a collection of photos into a great documentary style slideshow – with effects
like those used in the award-winning documentaries on PBS!  The secret is the powerful
Pan/Crop feature, which lets you pan across and zoom in and zoom out on still photos or video
clips.

These simple but powerful effects can bring motion and excitement to what would otherwise be
just a series of static shots. Here are some helpful hints to give your productions that profession-
al pizzazz:

A Quick Course on Adding Movement to Photos and Video Clips

� Use these easy steps to put together a stylish slideshow:

1. Import your photo and video clips into the Media Pool.

a. Use the Import Media command in the File Menu  -or- 

b. Click the Import Media button on the Media Pool tab.

2. Drop your first clip onto the Timeline.

3. To add motion, start by opening the Video Event Properties window for the clip. To do
this, you can:

a. Click the FX button in the lower right corner of a clip on the timeline.

b. Right-click on a clip and choose Video Event Pan/Crop from the drop down
menu.

4. Select the Pan/Crop tab in the Video Event Properties Window.

5. Use the tools in this window to crop, zoom, rotate, and pan the clip. The next section
provides more detail on using these functions.

6. Add these effects to each still shot or video clip in your production as needed to provide
a sense of motion and excitement.

MovieStudio_ FINAL_EN.qxd  2/24/04  11:52 AM  Page 86



SCREENBLAST MOVIE STUDIO SOFTWARE 87

Chapter 6: Editing Events, Adding Transitions and Effects

Using the Pan/Crop Tool
To access the Pan/Crop tool, open the Video Event Properties window for the clip you want to
work with (as detailed in step 3 above) and then click the Pan/Crop tab.

The right pane of the window shows the first frame of the selected clip. The selection box (with
the letter F for Frame) demonstrates the part of the image that will be shown in the video. By
resizing, moving, or rotating the frame box, you can set the size, position and rotation angle of
the clip. To crop the frame, use the crop handles to drag the corners and sides of the selection
box.

As you crop the frame, the numeric displays at left will show the size, position and angle of the
image. You can also change these parameters directly by typing into the number fields. This will
either zoom in or out of the photo or video clip, creating a zoom effect like the digital zoom on a
camcorder. Once you’ve made your settings, click the play button in the lower left corner of the
Pan/Crop window to preview the clip with the crop settings.

This setting will now remain for the rest of the clip. To add the motion of active zooming or pan-
ning, read on – the next section tells you how.

The Pan/Crop Window

Begin and 
End settings

Crop handles
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Animating the Clip with Panning and Cropping (Zooming)
While you are in the Pan/Crop Window, use the Begin and End buttons together to animate pan-
ning and cropping. This will give the illusion of motion, including zoom in and zoom out.

When you first open the Pan/Crop window, the Begin button will be selected. This sets the
selected Pan/Crop settings for the first frame of the clip. Once this is set, click on the End button.
Now, any changes you make in size and position of the frame will define the destination for the
last frame of the clip. The Screenblast Movie Studio software will automatically fill in all of the
rest! 

Zoom
To apply a zoom effect to the clip, follow these steps:

1. Click the Begin button.

2. Adjust the Pan/Crop settings to the way you want the first frame to appear.

3. Click the End button.

4. Adjust the Pan/Crop settings to focus on a larger or smaller section of the video.

Now when you play the clip, the frame will gradually zoom from the area on the first frame to the
area you selected in step 4.

Pan
This will keep the same zoom level, but will cause a panning motion across the clip.

To make a smooth panning motion across the frame without zooming:

1. Click the Begin button.

2. Adjust the Pan/Crop settings to the way you want the first frame to appear.

3. Click the End button.

4. Drag the entire box to a different area of the frame.

Now when you play the clip, the frame will move across the frame in a smooth panning motion.
And, if you resize the box when you move it, the effect will be a simultaneous zoom and pan!
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Menu Commands in the Pan/Crop Window
For even more control while using the Pan/Crop function, right-click the mouse inside the frame
area on the right of the Pan/Crop window to drop down a menu of useful commands for sizing
the pan/crop settings:

Multiple Moves on a Single Shot
With Screenblast Movie Studio video editing software, it’s possible to do multiple moves on a
single clip. For example, you may want to have the Pan/Crop effect move in on a section of the
clip, pause there for a bit, then move on to something else in the clip or change zoom. How can
you do this when the Pan/Crop tool only allows one Beginning setting and one Ending setting?
Well, it’s actually pretty easy… Just keep two things in mind: use separate instances of the clip
for each move, and use Presets to insure continuity.

Here’s how:

Break it Down
To make multiple moves, use a separate copy of the same clip for each move you want to make
– in other words, break it down into a series of moves. For example, let’s say that you have a
photo of a group of friends. You want your production to start with the whole frame showing
everyone, and then pan over to a person on the right while zooming in on their face. Then you
want to pause there for a moment, then pan over to a person on the left side of the frame,
pause there for a moment and then fade out. We can break this down into four separate
instances of the same event with different settings as follows:

1. Zoom and pan from group to person on right

2. Still shot of person on the right

3. Pan move from person on right to person on left

Telephone/Fax Country

Restore Returns the crop area to full frame.
Center Moves the crop area to the center of the frame.
Flip Horizontal Flips the event left to right and backwards.
Flip Vertical Flips the event top to bottom and backwards.
Match Output Aspect Sets the x,y ratio to the output value.
Match Source Aspect Sets the x,y value to the source media.
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4. Still shot and fade out of person on left

By dropping four instances of the same event end to end in the timeline, you can then apply the
effect for each move separately to each instance of the event.

Continuity
But how do you insure continuity?  Each time you drop an instance of the master clip into the
timeline, it starts with the whole image. To make a seamless transition, each subsequent clip in
the sequence has to use the same zoom and pan settings as the last frame of the previous clip.
Otherwise the frame will jump back to the whole picture at the edit point – not the effect we’re
looking for.

Fortunately, the Screenblast Movie Studio software features Presets, an easy way to create
continuity using the Pan/Crop function. The Preset function lets you name and store a Preset
with the exact settings of the current Size, Center, and Angle Position parameters.

Here’s the step-by-step method to make smooth moves from clip to clip in the sequence:

1. Open the Video Properties window and Pan/Crop tab for the first clip.

2. Click the End button to go to the Pan/Crop settings for the last frame of the clip.

3. Type a name for these position settings in the Preset name box.

4. Click the Floppy Disk Icon to save the settings as a Preset.

5. Close the Video Properties window for this clip.

6. Open the Video Properties window and Pan/Crop tab for the next clip.

7. Click the Begin button then select the preset you saved from the Preset menu.

8. This clip now starts with the same settings as the end of the last clip.

9. Click the End button and set the position for the last frame of the clip.

10. Continue this process for each instance of the clip for all subsequent moves.

Voila!  In just ten steps, the end result shows multiple moves flowing smoothly into each other on
a single clip.
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Removing Animation
If you add crop and zoom effects to a photo or video clip and you want to remove that effect,
then clear the check box next to the End button to remove animation. The beginning setting you
applied will be used for the duration of the effect.

Chroma Keyer Filter
Want to look like you’re standing on the White House lawn or maybe on the moon? This power-
ful video effect allows you to place a subject in your video in a different place or against a back-
ground of your choosing through the use of what is called a Chroma Key. This is the effect that
lets you appear to be in another city, or appear in a scene with a famous actor you’ve never
met, or even show you flying around the world. It’s the same effect used in professional
Hollywood films and is used every day by your TV weather person to let them appear in front of
the background maps during the weather broadcast. Here’s how it works…

The Chroma Keyer effect allows you to select a color or range of colors from source material
and remove that color or range of colors. You can then replace that color with other source
material, including moving video media, color changes, filters, mattes, or any number
of other options.

Chromakeying is sometimes referred to a “Blue Screen,” or “Green Screen.” That’s because, in
the past, chromakeying required a special blue or green background for clean removal.
Technology is allowing that tradition to change – any color can be used, not just blue or green.
In fact, the Screenblast Movie Studio software is unique because it even allows you to select
multiple colors for key information. Use the Chroma Keyer filter to determine transparency.

This filter is a mask filter that uses color (RGB or HSL values).

To use chromakeying on an event, choose the desired Chroma key effect from the FX tab and
drag it onto the video event you wish to affect in the timeline. The Video Event Properties win-
dow will open so you can adjust the settings of the event.
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Saving Your Project
When you save your work, it is saved in a project file (.vf). Project files are not rendered media
files. We recommend saving your project at regular intervals to avoid loss of work due to system
failure or power outages.

� To Save The Project For The First Time:

1. From the File menu, choose Save Project As. The Save As dialog displays.

2. Select the drive and folder where you want to store the project. The Screenblast Movie
Studio program automatically uses the project path you specified when you created the
project.

3. Enter a file name, if desired. The Screenblast Movie Studio software automatically uses
the project name you chose when you created the project.

4. If desired, select the Copy All Media With Project check box. This is an important
selection:

Chapter 6: Editing Events, Adding Transitions and Effects

Item Description

Show Mask Only Use these color controls to select the specific color you want to key out.

RGB/HSL Switches the color swatches from Red, Green and Blue values to Hue, Saturation, and
Luminance.

Eyedropper Click on the eyedropper then on the color in the source video (on the timeline) to deter-
mine the transparent key color.

Low Threshold The Chroma Keyer filter creates a mask for each frame. The mask works similar to an
alpha channel. Low Threshold allows adjustment of the luminance value of the mask.
Anything in the mask with luminance values below this setting become transparent.
Combined with the high threshold setting, a range of luminance is created for the mask.

High Threshold The Chroma Keyer filter creates a mask for each frame. The mask works similar to an
alpha channel. High Threshold allows adjustment of the luma value of the mask.
Anything in the mask with luminance values above this setting become opaque.
Combined with the low threshold setting, a range of luminance is created for the mask.

Blur Amount This controls how the edges of the key mask are treated. High values allow the mask to
blend more smoothly into the background video.

Show Mask Only Generates a mask from the settings in the dialog. This is identical to using the mask
Generator to create a mask.
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5. If the check box is selected, all of the media in the project will be copied into the same
folder as the project file, making transporting the project easy and convenient. If this
check box is not selected, the Screenblast Movie Studio software saves the references
to the media files used in the project.

6. Click the Save button.

In subsequent saves, the Save As dialog is bypassed, your existing file name is retained, and
your project is updated to include all implemented changes.
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Adding Embedded Commands in Streaming Media 

You may already know that the Screenblast Movie Studio video editing software is a great

program for creating streaming media versions of your video files so that you can publish

them to the web. However, did you also know that the Screenblast Movie Studio software

provides you with the power to add embedded commands in your streaming media files to

provide even more interactivity as well as other information? 

The Screenblast Movie Studio application uses Command Markers to indicate when an

instruction (function) will occur in a streaming media file. You can use Command Markers

to display headlines, captions, link to Web sites, or any other function you define. Here’s an

overview of commands available in this powerful tool:

Command Player Type         Description

URL Windows Media
and RealMedia

Indicates when an instruction is sent to the user’s
Internet browser to change the content being displayed.
With this command, you enter the URL that will display at
a specific time during the rendered project’s playback.

Text Windows Media
Displays text in the captioning area of the Windows
Media Player located below the video display area.
You enter the text that will display during playback.

Windows Media Displays the entered text in the captioning window that is
defined by an HTML layout file.

WMTextBodyText Windows Media Displays the entered text in the text window that is
defined by an HTML layout file.

Title Windows Media
and RealMedia

Displays the text you enter to identify the file's title in a
media player.

Author
Windows Media
and RealMedia

Displays the text you enter when you choose About this
Presentation from the RealPlayer’s shortcut menu or
Properties from the Windows Media Player shortcut menu.

Copyright
Windows Media
and RealMedia

Displays the text you enter when you choose About this
Presentation from the RealPlayer’s shortcut menu or
Properties from the Windows Media Player shortcut menu.

HotSpotPlay RealMedia
Allows you to define an area in the RealPlayer video display
that users can click to jump to another RealMedia file.

HotSpotBrowse RealMedia
Allows you to define an area in the RealPlayer video display
that users can click to jump to a Web page that you specify.

HotSpotSeek RealMedia
Allows you to define an area in the RealPlayer video 
display that users can click to jump to a point in the 
current RealMedia file.

WMClosedCaption
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While creating your videos in the Screenblast Movie Studio software, you can add commands
directly to the Timeline. Here’s how:

Insert a Command Marker
1. Place the cursor where you want to insert the command marker.

2. From the Insert menu, choose Command. The Command Properties dialog is dis-
played.

3. From the Command drop-down list, choose the type of command you want to insert, or
type a custom command in the box.

4. In the Parameter box, enter the argument that should be passed to the command. For
example, if you're using an URL command, enter the URL of the Web page you want to
display.

5. In the Comments box, enter any comments you want to associate with the command. A
comment is generally used to remind you of what the command is while you work on
the project; its function is similar to naming markers and regions.

6. In the Position box, enter the time you want the command to occur in your project. The
Screenblast Movie Studio software inserts at the cursor position by default. Right-click
the command marker tab and choose Delete from the shortcut menu.

To Delete a Command marker
Right-click the command marker tab and
choose Delete from the shortcut menu.

To Edit a Command marker
Right-click the command marker tab and
choose Edit from the shortcut menu.

-or-

Double-click the command marker tab.

To Move the Cursor to a Command Marker:
Click the command marker tab.

Not Just For Power Users
While this is an advanced feature that many people will never use, it does provide a great way to
add more interactivity and information to your streaming media files. For example, you can add
text that will display when someone plays your movie using the Windows media player, or make
a button on your video in the Real player that a user can click to open a web site or go to anoth-
er video.

This special feature of the Screenblast Movie Studio software makes it pretty easy to add some
extra pizzazz to your streaming media files – try it and impress your friends! 
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Output Formats in the Screenblast Movie Studio
Application
The Screenblast® Movie Studio™ application now supports more output formats than ever
before. To render a movie in a desired format, use the Make Movie function from the File menu.
The Make Movie window provides eight different choices for file output destinations. The avail-
able file output types are tailored to the destination, so that not all files formats are available for
every output destination. Here is a table that summarizes which output file types are available for
each Make Movie destination.

� Output Formats Supported In 
the Application

� Using the Make Movie Wizard
to Output Your Movie

� What is Rendering?

� Digital Video on Disc: VCD 
and DVD

� What is MPEG?

� Streaming Media Technology 
and Formats

This chapter provides details on
how to output and share your

movie. Once you’ve created a video
using Screenblast Movie Studio, there
are several ways to share it with your
friends and family. You can put it on
disc, videotape, email it, put it on a
web page, export to Sony Memory
Stick or Giga Vault, make a streaming
media file. Screenblast Movie Studio
software also includes the ability to
encode your movie into the MPEG-1
and MPEG-2 formats. 

MovieStudio_ FINAL_EN.qxd  2/24/04  11:53 AM  Page 96



SCREENBLAST MOVIE STUDIO SOFTWARE 97

Chapter 7: Sharing Your Finished Videos

Creating a Movie File
You’ve created your project, previewed it
and edited it until it’s absolutely perfect.
Now you’re ready to share it with the
world! The Make Movie wizard, which
you can start by clicking the Make Movie
button ( ) on the main toolbar, or
by choosing the Make Movie item from
the File menu, will guide you through the
process of saving your movie in various
formats so you can share it with others.
After selecting either of these, the Make
Movie Wizard appears:

Make Movie Output Destination File Types Supported

• Video for Windows (.avi)

• MPEG-1 (.mpg

• Save it to Sony® Memory Stick® media or 
Sony® Giga Vault™ portable hard disk media

• E-mail it.
• Create an HTML page that includes it

• Save it to your hard drive 
• Save it to your camcorder’s DV tape

• Burn it to DVD

• Burn it to Video CD

• Burn it to CD-ROM

• MPEG-1 (.mpg)
• MPEG-2 (.mpg)
• OggVorbis (.ogg)
• QuickTime 5 (.mov)
• Real Media 9 (.rm)
• Sony Audio (.sfa)
• Soy Perfect Clarity Audio (.pca)

• Sony Wave64 (.w64)
• Video for Windows (.avi)
• Wave (Microsoft) (.wav)•
• Flash Video (1-pass VBR) (.swf)
• Windows Media Audio V9 (.wma)
• Windows Media Video V9 (.wmv)

• MPEG-1 (.mpg)
• MPEG-2 (.mpg)
• QuickTime 5 (.mov)
• Real Media 9 (.rm)

• Video for Windows (.avi)
• Flash Video (1-pass VBR) (.swf)
• Windows Media Video V9 (.wmv)

• Video for Windows (.avi)
• QuickTime 5 (.mov)
• Real Media 9 (.rm)

• Flash Video (1-pass VBR) (.swf)
• Windows Media Video V9 (.wmv)
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What is Rendering and Why Does it 
Sometimes Take Take so Long?

When you’ve finished editing a project, the final movie is made by a process called rendering,
which is done using the Make Movie menu. If you’ve tried this already, then you’ve probably
noticed that if you have a large or complex movie rendering can sometimes take a while. Why
does it take so long?

Think of your project as a mixed-up puzzle of various video clips, transition effects, video 
overlays, and all of the audio tracks such as music, effects, and dialogue. There may even be
other special effects such as Chroma key, panning and cropping, Video Time-Stretch, or maybe
sepia tone effects that make your movie look like an old film. All of these pieces can add up to a
lot of things going on at once.

The Screenblast Movie Studio video editing software takes all of these jumbled pieces and
seamlessly puts them all together, scrunching them all down into one single file. To create a 
single file that can be burned to a CD, DVD, or saved to a hard drive or DV tape, the computer
has to calculate the total effect of the combination of each and every one of these elements.

Finally, it has to compress that single file into whatever type of video and audio compression
you’ve called for (MPEG-1, MPEG-2, Real Video, QuickTime, Windows Media 9, etc.) - and that
can take a lot of number crunching!  

Speaking of number crunching, keep in mind that having a faster processor can reduce the time
required to render your movie. That’s because that latest 3 GHz + processor can crunch more
numbers faster than, say, a 1GHz processor – three times faster, in fact..

Also, generally speaking, the longer the video, the longer the render time. Noting that, you will
soon be able to predict and plan for your movie’s rendering time.

One of the most powerful features of the Screenblast Movie Studio software is Real-Time
Previewing, which means that you don’t have to render every time you want to check out what
you’ve done so far. In fact, at any time during your editing session, just press the Play button
underneath the timeline to preview your video. The Real-Time Preview feature will save you tons
of time as you won’t have to render your movie every single time you want to see how a particu-
lar transition looks in your movie.

Finally, one time-saving tip to keep in mind is that if you want to see what the most complex part
of the movie will look like when rendered, you can render just a selected region to check it
before rendering the entire movie.

So, sit back, relax, and let the render process happen – because once its over, you will have
taken a jumble of video and audio clips and made a movie you can burn to CD, DVD, or share
with others on the web – and that’s what makes the Screenblast Movie Studio software so pow-
erful -- and so much fun!
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This section will walk you through each of the options in the Make Movie wizard.

Save It to Your Hard Drive
When you use the “Save it to your hard drive” option on the Make Movie wizard, the Screenblast
Movie Studio software will convert your project to the format you choose and create a single file
on the drive you choose. This process is called rendering.

The project file is not affected (overwritten, deleted, or altered) during the rendering process.
You may return to the original project to make edits or adjustments and render it again.

Rendering Your Movie
1. From the File menu, choose Make Movie, or click the Make Movie button ( ) on

the toolbar.

2. Click the Save it to your hard drive button and click the Next button. The Make Movie
Render Settings window appears:

3. In the File path field, type the path to the folder where you want to save your movie, or
click the Browse button to navigate to the folder.

4. From the Format drop-down list, choose the type of file you want to create.
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5. Choose a setting from the Template drop-down list to specify the settings that will be
used to save your file. The settings for the selected template are displayed in the
Description field. If you want more control, click the Advanced Render button to close
the Make Movie wizard and open the Render As dialog.

6. Select the Render Loop Region Only check box if you only want to render a portion of
your project. If the check box is cleared, the entire project will be rendered to a new file.

7. Select the Stretch Video to Fill Output Frame check box if you want the Screenblast
Movie Studio software to reformat your video so it fills the output frame size listed in the
Description field. When the check box is cleared, the Screenblast Movie Studio software
maintains the current aspect ratio and adds black borders to fill the extra frame area
(called letterboxing). This option is useful when the desired output format does not
match the frame aspect ratio of your project.

8. Clear the Fast Video Resizing check box if you see unacceptable artifacts in theren-
dered video (these artifacts will be most obvious with streaming and MPEG formats).
Turning off this option can correct the artifacts, but your rendering times may increase
significantly.

9. If you plan to present your movie online, check the download times for your movie.

a. Choose a setting from the drop-down list to choose an Internet connection type.

b. The Screenblast Movie Studio software displays the estimated size of the movie,
the available free space on your hard drive, and the amount of time it will take
someone to download your movie with the selected connection type.

c. If the download time is fairly long for the Internet connection type that most peo-
ple will use to see your movie, choose another setting from the “Template” drop-
down list to whittle your movie to a manageable size.

10. Click the Next button. The Screenblast Movie Studio software then renders your movie.

11. When rendering is complete, you can click Play File to play your movie using the default
player for the selected format, or click Explore Folder to view the folder where you
saved the movie with the Windows Explorer.

12. Click the Finish button to close the Make Movie wizard.

NOTE: When making a movie file, whether writing to disk, a DV tape, VCD, CD-ROM, or any other output format, if you see unac-

ceptable artifacts in the rendered video, try clearing the Fast Video Resizing check box to see if turning off this option can correct

the artifacts. Note that if you do this, your rendering times will increase significantly.
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When you’re finished with your video, you will have several choices on ways to share it with

friends and family. You can publish your video to Screenblast.com in order to easily share your

creations online with friends and family, or you can burn a VCD or a DVD (assuming that you

have a CD burner or a DVD burner.)  Here’s a quick look at the differences between the VCD

and DVD formats.

VCD

VCD stands for “Video Compact Disc.” This is essentially a Compact Disc (CD) that holds mov-

ing pictures, still pictures, and sound. VCDs are quite common in Asia, where the format still

enjoys great popularity and has practically replaced the VHS tape. A VCD comes in two varieties

that can hold up to 74 minutes (650MB) or 80 minutes (700MB) of full-motion video plus stereo

sound.

VCDs use the MPEG-1 compression standard for video and audio. While a few standalone DVD

players and CD and DVD-based video game systems may have problems with VCDs, they will

play on most computers with a DVD-ROM or CD-ROM drive (when used with a software-based

decoder & player). VCD video resolution is 352x240 pixels in the NTSC format, with quality that

is roughly similar to VHS tape.

VCDs can have up to 99 index points and can play video, audio, and still images. In addition to

video, VCDs can be used for still picture photo albums and slide shows with audio.

DVD

Bigger, faster, better. The “Digital Versatile Disc” -- or DVD -- is the most quickly adopted video

technology to ever find mass-market acceptance.

The key elements that make DVD so exciting are its extreme versatility – lots of interactivity,

powerful variable bit-rate MPEG-2 video compression, multiple audio format support, extra large

storage capacity, and more. DVD now enjoys universal support from every consumer electronics

manufacturer and Hollywood studio making it the most well accepted format in the world for

delivering video content.

There are a variety of recordable DVD types and several different DVD specifications for total

recording capacity. These are discussed in a separate article called “DVD Formats.”
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This chart gives further details on the capabilities

of the VCD and DVD formats.

Featurea VCD 2.0

Video MPEG-1

Bit rate
NTSC resolution
PAL resolution

Fixed – 1150 Kbps
352x240 interlaced, 29.97FPS
352x288 interlaced, 25FPS

Audio MPEG-1 layer II

Sample rate
Bit rate 
Audio channels

44.1kHz
224 Kbps

Stereo

Total bit rate 1294.4 Kbps

Feature DVD

Video MPEG-1

Bit rate
NTSC resolution
PAL resolution

Variable - 3 Mbps - 8 Mbps
720x480 interlaced, 29.97Hz
720x576 interlaced, 25Hz

Audio MPEG-1 layer II MPEG1, MPEG2, Dolby AC3, DTS, PCM

Sample rate
Bit rate 
Audio channels

48 or 96 kHz with 16, 20, or 24 bits/sample
from 192-448 Kbps
8 audio tracks (streams) associated with a video track

Still picture 
(graphic, photo)

MPEG-2   I Frame (Authoring system work with 
common graphics files types – GIF, JPEG, Photoshop,
TIFF, etc. )

Formats supported Dolby Digital (formerly AC-3): 1 to 5.1 channels
MPEG-2 audio: 1 to 5.1 or 7.1 channels 
PCM: 1 to 8 channels
Optional formats: DTS and SDDS
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Write Your Movie to DVD
If you plan to write your movie to a DVD disc, choose the Burn it to DVD option in the Make
Movie window. The Screenblast Movie Studio package now includes the Sonic MyDVD applica-
tion so that you can easily write your movies onto recordable DVDs that can be played on most
home DVD players or computers with DVD drives and a DVD player application.

Before you can use the Sonic MyDVD application to burn the disc please make sure that you
have installed the SonicMyDVD application from the CD installation splash screen. Also, please
note that you will have to use the Screenblast Movie Studio software to save your movie as an
.avi file. Once the movie is saved as a .avi file, you can import it into your DVD burning 
application. Here’s how...

1. After choosing the Burn it to DVD option in the Make Movie window, click Next

2. In the File path field, type the path to the folder where you want to save your movie, or
click the Browse button to navigate to the folder.

3. Once you’ve defined the path, click Next to begin saving your movie as a .avi file.

4. Once the movie is saved as .avi file, you can use your DVD burning software to import
the .avi file and complete the authoring and DVD burning process in that application.
See Chapter 8 Using Sonic My DVD for more information.

Write Your Movie to Video CD or CD-ROM 
If you want to share your movie with someone who does not have an ultra-fast Internet 
connection, your best bet is often to create a CD with your movie on it. When you create 
a Video CD (VCD) or CD-ROM, you can share a high-quality version of the movie without 
having to worry about download times.

Video CDs can be played in most DVD players and on computers with a CD-ROM drive and
VCD player software. CD-ROMs can be played in any computer with the appropriate player.

Creating a Video CD (VCD):
1. Click the Make Movie button ( ) on the toolbar.

2. Click the Write Your Movie to Video CD or CD-ROM button and click the Next button.

3. Select the Create a Video CD radio button and click Next.

4. Choose the movie file you want to use

� If you want to render the current project, select the Render Your Project to this
Format button.
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a. Select the Render Loop Region Only check box if you want to use only a por-
tion of your project. If the check box is cleared, the entire project will be rendered
and saved to the Video CD.

b. Select the Stretch Video to Fill Output Frame check box if you want the
Screenblast Movie Studio program to reformat your video so it fills the out put
frame size listed in the Description field. When the check box is cleared, the
Screenblast Movie Studio software maintains the current aspect ratio and adds
black borders to fill the extra frame area (called letterboxing). This option is useful
when the desired output format does not match the frame aspect ratio of your
project.

� If you want to use an already-rendered MPEG file, select the Use an Existing File
radio button, and enter the path to the file in the File path field (or click the Browse
button to locate the file).

5. Click the Next button. The Screenblast Movie Studio program then renders your movie,
if necessary.

6. Select recording options for your CD-recordable drive:

a. Choose your drive from the Write Drive drop-down list.

b. From the Write Speed drop-down list, choose the speed at which you want to
record. The Max option will record using the fastest speed possible with your
drive; decrease the speed if you have difficulty recording.

c. Choose a write mode:

� Choose Write CD to create your CD when you click the Next button.

� Select Test Only (do not write CD) if you want to test whether you can record
at the selected speed.

7. The Screenblast Movie Studio software records your movie to the CD. When recording is
finished, you can select the Save Movie File check box to keep the MPEG file that was
rendered, or you can clear the check box to delete the file.

8. Click the Finish button.

Proper Use of Software

The Screenblast Movie Studio software is not intended, and should not be used for, illegal or infringing purposes,
such as the illegal copying or sharing of copyrighted materials. Using the Screenblast Movie Studio software for
such purposes is, among other things, against United States and international copyright laws and contrary to the
terms and conditions of the End User License Agreement. Such activity may be punishable by law and may also
subject you to the breach remedies set forth in the End User License Agreement.
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Save Your Movie to Sony Memory Stick Media or Sony Giga Vault
Portable Hard Disk Media
Sony Memory Stick and Sony Giga Vault provide lightweight, easily transportable storage for
your digital media files. The Screenblast Movie Studio application allows you to conveniently
save your movie projects to these Sony storage devices when they are connected to your PC
using a USB connection. Here’s how -

1. Choose the Make Movie window option called Save it to Sony Memory Stick media or
Sony Giga Vault portable hard disk media, then click Next.

2. In the File path field, type the path to the folder where you want to save your movie, or
click the Browse button to navigate to the folder, then click Next.

Save Your Movie to Your Camcorder’s DV tape
If you want to share your movie with someone who doesn’t have a computer, you can use the
Print your movie to DV tape option to convert your project to a format that you can use to record
your movie back to your camcorder.

1. Click the Make Movie button ( ) on the toolbar.

2. Click the Save it to your camcorder’s DV Tape button and click the Next button.

3. Select the Render Your Project to this Format radio button.

4. In the File Path field, type the path to the folder where you want to save your movie, or
click the Browse button to navigate to the folder.

Note: The Screenblast Movie Studio program needs to render a file using the correct format for your camcorder before it records

your movie to tape. This is the location where the file will be created.

5. Choose a setting from the Template drop-down list to specify the settings that will be
used to save your file.

6. Select the Render Loop Region Only check box if you want to record only a portion of
your project. If the check box is cleared, the entire project will be rendered and recorded
to tape.

7. Select the Stretch Video to Fill Output Frame check box if you want the Screenblast
Movie Studio software to reformat your video so it fills the output frame size listed in the
Description field. When the check box is cleared, the Screenblast Movie Studio software
maintains the current aspect ratio and adds black borders to fill the extra frame area
(called letterboxing). This option is useful when the desired output format does not
match the frame aspect ratio of your project.
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8. Click the Next button. The Screenblast Movie Studio program renders your movie.

9. When rendering is complete, the Screenblast Video Capture feature starts to allow you
to record your movie to tape. For more information about using Video Capture, please
see the Video Capture Help file (accessible from the Help menu by choosing Contents
and Index).

Send Your Movie via E-mail
You can also share your movie with someone who has e-mail access. The Make Movie wizard
allows you to send a movie by E-mail, too.

Note: Movie files can be very large, so be considerate of your audience’s

Internet connection: some files might take a very long time over a 56K connection

1. Click the Make Movie button ( ) on the toolbar.

2. Click the E-mail it button and click the Next button.

3. Select the Render Your Project to this Format button.

4. In the File path field, type the path to the file where you want to save your movie, or click
the Browse button to navigate to the folder.

Note: The Screenblast Movie Studio software needs to create a movie file 

before you can send it. This is the location where the file will be created.

5. From the Format drop-down list, choose the type of file you want to create.

6. Choose a setting from the Template drop-down list to specify the settings that will be
used to save your file.

7. Select the Render Loop Region Only check box if you only want to render a portion of
your project. If the check box is cleared, the entire project will be rendered to a new file.

8. Select the Stretch video to fill output frame check box if you want the Screenblast Movie
Studio program to reformat your video so it fills the output frame size listed in the
Description field. When the check box is cleared, the Screenblast Movie Studio program 
maintains the current aspect ratio and adds black borders to fill the extra frame area.
This option is useful when the desired output format does not match the frame aspect
ratio of your project.
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9. Check the download times for your movie.

a. Choose a setting from the drop-down list to choose an Internet connection type.

b. The Screenblast Movie Studio program displays the estimated size of the movie,
the available free space on your hard drive, and the amount of time it will take
someone to download your movie with the selected connection type.

c. If the download time is fairly long for the Internet connection type that most peo-
ple will use to see your movie, choose another setting from the Template drop-
down list to whittle your movie to a manageable size.

10. Click the Next button. The Screenblast Movie Studio program renders your movie.

11. When rendering is complete, the Screenblast Movie Studio program starts your default
e-mail program and creates a new message with your movie attached.
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What is MPEG?

How do you squeeze big video and audio files into a small package that can fit on a disc, your
computer, or the Internet?

MPEG creates digital media standards that are used worldwide. These standards that MPEG
developed have made possible advances such as Video CDs, DVDs, Digital Cable TV, MP3
audio, and video on your cell phone. So, how does it work? And what’s the difference between
MPEG-1, MPEG-2, and MP3? 

When an uncompressed, full resolution video image is digitized, the resulting computer file
occupies a very large amount of computer memory. The various MPEG formats are designed to
produce incredibly smaller (and much more usable) digital files by basically crunching the video
or audio file into a smaller size. This process is called data compression and it allows the digital
video/audio to work within the constraints of a device’s processing power, memory, and drive
storage capacity while maintaining acceptable quality.

The basic principal behind MPEG video compression is to use fewer bits to encode the video by
predicting how parts of the image will change in successive frames and then using a kind of dig-
ital ‘shorthand’ to describe the difference between the prediction and the actual frame.

Altogether, this method uses a lot less bits than would be required if all of the information for
each frame was captured separately, but still produces excellent image quality.

MPEG-1
MPEG-1 typically produces quality roughly equivalent to VHS videotape and is most often used
at a resolution of 352x240 pixels at 30 frames per second (NTSC). MPEG-1 provides a way of
using digital video files on CD-ROMs and is used today for VCD discs. The MP3 audio format is
also part of MPEG-1, and is actually defined as Layer 3 in the MPEG-1 specification, hence the
popular term MP3 (MPEG-1, layer 3).

MPEG-2
MPEG-2 is the standard used for DVDs, digital cable set top boxes, and digital television broad-
casting. It allows for better compression as well as higher quality than MPEG-1. MPEG-2 is most
commonly used at 720x480 pixels at 30 frames per second (NTSC) for DVD and Digital TV
broadcasting. The new audio compression format in MPEG-2 is called Advanced Audio Coding
(AAC). It features more advanced compression while producing better audio quality than MP3.
Remember that MPEG-1 is the type of compression used for Video CD (VCD), while MPEG-2 is
always used for DVD discs.

MPEG-4
MPEG-4 is the most recent of the standards and is the most ambitious in that it not only
includes an improved compression scheme for digital media, but it also includes methods to
describe different areas in a video image as separate video objects. This allows for advanced
features such as user interactivity with parts of the video. MPEG-4 can also scale the picture
and sound quality intelligently to fit the device it is being played on. It is currently being used to
bring video into consumer products such as cell phones and personal digital assistants, as well
as streaming media, animated graphics, and interactive television.
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What are I-frames, P-frames, and B-frames in MPEG?
The compression scheme relies on things called I-frames, P-frames, and B-frames. Successive
frames in a video stream usually have a lot of pixels that don’t change or change gradually over
time. For example, the background in a scene remains largely the same while the changes are in
the action of the characters. The basic principal behind MPEG video compression is to use fewer
bits to encode the video by predicting what  parts of the image will remain the same and which
will change in successive frames and then using a kind of digital ‘shorthand’ to describe those
changes.

It works something like this: first a lot of detail is captured in a reference frame of video, called the
Intra-frame or I-frame. Next, based on an analysis of how the content of the frame changes over
time, MPEG compression predicts the makeup of the next frame, called a Predicted Frame or P-
Frame. It then only encodes the difference between the prediction and the actual frame. To further
squeeze the image into a smaller number of bits, another kind of frame called a Bi-directional or
B-frame is created. These B-frames use both the full resolution I-frames and the P-frames to cal-
culate what bits are needed to encode those frames.

What this means for you is that the MPEG compression process uses a bit of very cleverpredic-
tion to make your video files small enough to allow you to view and edit them on yourcomputer
and other devices.

Create an HTML Page that Includes Your Movie
Posting your completed movie to a web page has never been easier! You can use the Make
Movie function to automatically create a web page with your movie embedded in a media player.

�To create a webpage with your movie embedded:

1. Choose the option called Create an HTML page that includes it in the Make Movie win-
dow, and then click Next.

2. The Summary Information window for your movie opens - fill in the blanks andclick Next.

3. Select the appropriate settings in the next window to render your file. Click Next to begin
the rendering process.
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4. After the movie has been rendered in
the format you specified, the HTML
page is automatically created. The infor-
mation you provided on the sum
mary info page is integrated and an
appropriate media player for the media
file type you chose will automatically
appear on the page. A new window
appears which offers the choice to play
the file or open the file with Explorer.

5. To display and play the page in your
HTML browser, click Play File. To open
Explorer and locate the file, click
Explorer Folder.

After the page is created, you can then use your
favorite HTML editing program to further edit
your page and post it to the web.

Select thr appropriate settings to render your file.

Select the appropriate settings to render your file.

An HTML page created using this function

displayed in Internet Explorer.
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Streaming Media: Technology & Formats
RealMedia®, Windows Media™, QuickTime®, Flash

Streaming media refers to audio and video content from an Internet site that can be played
on your computer in real time without requiring you to actually download and save the files
first. Since video and audio files can be very large, downloading them before playing may
take several minutes or even hours.

Streaming media lets you enjoy the video or audio experience without the long wait.
Streaming media files are not usually stored to the computer’s hard disk. Instead, they use
a part of the computer’s memory as a buffer to store a part of the file while it plays.
Buffering allows the video or audio file to play smoothly even though the download rate
may vary.

Most streaming technologies allow users to encode clips for multiple bandwidths. The goal
is to produce the best possible quality for the amount of bandwidth available. Media play-
back quality improves with higher speeds – so the audio and picture quality can be better
and frame rate higher for a stream delivered over a DSL line versus a 56K modem.

Formats
Here are some notes on the most important streaming technologies. Both Screenblast
Movie Studio software and Screenblast ACID 4.0 software support all of the formats.

RealNetworks: RealAudio and RealVideo 
RealAudio and RealVideo widely used formats for distributing both streaming audio and
video. All of the formats are played by the RealOne™ Player, which works on both Macs
and PCs.

Apple QuickTime
QuickTime provides excellent compression and multimedia authoring for Macs as well as
Windows PC. QuickTime is more than a file format - it also provides an environment for
complex media authoring, and a suite of related applications.

Windows Media 
Windows Media 9, the latest version of Windows Media Player, features advanced audio
coding (AAC) with better quality than MP3 at lower bit rates, and support for multiple video
resolutions and other powerful features.

Flash
Flash enjoys widespread use on the Internet. It uses vector graphics and other technolo-
gies to provide rich media experiences in a very compressed format that is easy to scale
and stream. Flash can integrate a lot of different types of media, including video, audio,
graphics, and text. Flash productions can also include a high degree of interactivity.
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Authoring and Burning DVD Discs with Sonic MyDVD
If you have a DVD burner attached to your computer, then you can use Sonic MyDVD to burn
interactive DVDs that will play in most consumer set-top DVD players. Or, if you have a CD burn-
er, then you can use it to burn VCDs that will play in most DVD players.

With the Sonic MyDVD™ software, you can select different menu styles in order to theme your
DVD to suit most occasions. The Screenblast® Movie Studio™ package also includes over forty
additional menu styles created by the Sony Pictures Digital Authoring Center.

The Sonic MyDVD application is powerful, yet simple and easy to learn. An HTML-based Tutorial
and Windows HTML- Help file for the Sonic MyDVD application is available from the opening
screen when you start the Sonic MyDVD application. You can also access these files anytime
form the Help menu of the Sonic MyDVD application.

If you haven’t already installed the Sonic MyDVD application from the Screenblast® Movie
Studio™ application CD-ROM, you’ll need to do so before you can access the application or the
Tutorial and Help files.

Note: The Sonic MyDVD application is included on the Screenblast Movie Studio CD-ROM, and can be installed by clicking on the

item called Install MyDVD 4.5 for DVD Authoring on the Screenblast Movie Studio software installation startup screen. 

� Using Sonic MyDVD Software 
to Author Your Movies for DVD

� DVD Recording Formats

� Reference Guide to Keyboard 
Shortcuts

T he Screenblast Movie Studio
video editing software now

includes the Sonic MyDVD
software. an excellent application 
for putting your video projects 
onto recordable DVD discs. 
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Recordable DVD Formats 

DVD-R?   DVD-RW?   DVD+R?  DVD+RW?  DVD RAM?  What does it all mean?  If you plan on
burning your own DVDs, then you should know about the format differences so that when it
comes time to watch your own homemade DVDs, there won’t be any problems. While there are
many similarities in these formats, there are also several important differences.

The first thing to know is that there are three main classes of DVD technology. The first class is
DVD R, which means DVD Recordable. These are blank recordable DVDs that can be burned
only once.

The second class of DVD format is the DVD RW, which stands for DVD ReWritable. These can
be recorded over and over again, like a floppy disk.

The third, DVD RAM, stands for DVD Random Access Memory and, like the DVD RW, these discs
can be recorded over and over again.
However, DVD RAM is generally not
compatible either with most DVD Rom
drives or DVD Players. Think of DVD-
RAM as a special kind of removable
optical drive for storing computer data
and not for writing video to be played
on your DVD player.

What can make things complex is that
there are two competing versions of the
DVD R and DVD RW. One is referred
to as the “Plus” format: DVD+R, and
DVD+RW (read as “DVD Plus R” and
“DVD Plus RW”) while the other is
referred to as the “Minus” format: DVD-
R, and DVD-RW (read as DVD Minus R
and DVD Minus RW).

Why does all this matter?  Well, it mat-
ters because you want to make certain
that the blank DVD media that you use works with your DVD burner and that the end result, a
DVD with your videos on it, can be played on most DVD Players.

It is also important to know that as far as compatibility with DVD players is concerned, not all
recordable DVDs are created equal. In fact, according to a recent study* done by the independent
testing corporation Intellikey Labs, DVD write-once and rewritable formats are compatible with the
following percentages of consumer DVD players:

Fortunately, to make it easier on you, the Screenblast Movie Studio video editing software sup-
ports all of the major DVD media types: DVD+R, DVD-R, DVD+RW, and DVD-RW. Of course, just
to be sure, check with the documentation that came with your DVD burner to make sure that you
are using the correct blank media.

*Source - Intellikey Labs 2002; contact info@intellikeylabs.com

Format Compatability

DVD+R 90 percent

DVD-R 77 Percent

DVD+RW 72 percent

DVD-RW 66 Percent
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Reference Guide to Keyboard Shortcuts 

In order to make editing and navigation go smoother and faster, the Screenblast Movie Studio
software features a variety of Keyboard Shortcuts for most commands.

Help Commands
Command Keyboard Shortcut

Help Contents and Index

Display What'sThis? Help

F1

Shift+F1

Project Commands
Command Keyboard Shortcut

Create new project

Open existing project

Save project

Project properties

Exit VideoFactory

Ctrl+N

Ctrl+O

Ctrl+S

Alt+Enter

Alt+F4

View Commands
Command Keyboard Shortcut

Zoom in on timeline

Zoom out on timeline

Zoom in large increments or selection

Zoom out large increments or selection

Zoom in vertically to audio tracks

Zoom out vertically to audio tracks

Increase track height

Decrease track height

Toggle between minimum track height and last

setting

Set tracks to two times minimum height

Set tracks to default height

Up Arrow

Down Arrow

Ctrl+Up Arrow

Ctrl+Down Arrow

Shift+Up Arrow

Shift+Down Arrw

Ctrl+Shift+Up Arrow

Ctrl+Shift+Down Arrow

`

Shift + `

Ctrl + `
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Transport Commands
Command Keyboard Shortcut

Play/Stop playback

Stop playback

Pause

Loop playback on/off

Scrub playback

Playback from any window

Record

Spacebar

Esc

Enter

Q

Ctrl+drag cursor on timeline

Ctrl+Spacebar or F12

Ctrl+R when audio track has focus

Cursor Placement Commands
Command Keyboard Shortcut

Move cursor one pixel right/left

Move cursor one video frame right/left

Move cursor left by grid marks

Move cursor right by grid marks

Move cursor left to event edit points including

fade edges

Move cursor right to event edit points including

fade edges

Go to beginning of selection or view 

(if no selection)

Go to end of selection or view (if no selection)

Go to beginning of project

Go to end of project

Center view around cursor

Toggle cursor between beginning and end of

selection

Jump to marker # or select region

Go to time

Right/Left Arrow

Alt+Right/Left Arrow

Page Up

Page Down

Ctrl+Alt+Left Arrow

Ctrl+Alt+Right Arrow

Home

End

Ctrl+Home

Ctrl+End

\

Keypad 5

0-9  (not keypad)

Ctrl+G
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Selection or Loop Region Commands
Most of the cursor placement commands will create a time or loop selection when
combined with the Shift key.

Window Commands
Command Keyboard Shortcut

Set focus to timeline

Set focus to Media Pool tab

Set focus to Transitions tab

Set focus to Video FX tab

Set focus to Text & Backdrops tab

Set focus to Explorer tab

Alt+0

Alt+1

Alt+2

Alt+3

Alt+4

Alt+5

Cursor Placement Commands
Command Keyboard Shortcut

Restore previous five selection areas

Mark In

Mark Out

Select loop region

Select duration of event

Select duration of transition

Snap select to Event Edges

Create time selection while dragging over events

Select All

Set selection end

Backspace

[ or I

] or O

Shift+Q

Double-click event

Double-click transition

Ctrl+Shift+Alt+Left or Right (arrow)

Ctrl+Shift+drag

Ctrl+A

Shift+Ctrl+G
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Event Selection Commands
Command Keyboard Shortcut

Range selection (Events)

Multiple selection (Events)

Select all events

Unselect all events

Shift+click range of objects

Ctrl+click individual objects

Ctrl+A

Ctrl+Shift+A

Edit Commands
Command Keyboard Shortcut

Undo

Redo

Cut selection

Copy selection

Paste from clipboard

Paste Insert from clipboard

Paste repeat from clipboard

Delete selection

Trim to selection

Open in Audio Editor

Split event(s) at cursor

Ctrl+Z

Ctrl+Shift+Z or Ctrl+Y

Ctrl+X or Shift+Delete

Ctrl+C or Ctrl+Insert

Ctrl+V or Shift+Insert

Ctrl+Shift+V

Ctrl+B

Delete

Ctrl+T

Ctrl+E

S

Insert Transition Commands
Command Keyboard Shortcut

Crossfade

Dissolve

Linear Wipe

Keypad /

Keypad *

Keypad -

SCREENBLAST MOVIE STUDIO SOFTWARE 117

MovieStudio_ FINAL_EN.qxd  2/24/04  11:53 AM  Page 117



Reference Guide to Keyboard Shortcuts 

Event Commands
Command Keyboard Shortcut

Next take

Previous take

Group events

Select all in group

Remove from group

Clear group

Open in audio editor

Open in image editor

Move selected event(s) right one pixel

Move selected event(s) left one pixel

Move selected event(s) right one frame

Move selected event(s) left one frame

Move selected event(s) right one grid mark

Move selected event(s) left one grid mark

Move selected event(s) up one track

Move selected event(s) down one Track

Stretch and change event playback rate

Slip Trim: move the media with the edge as it is

trimmed

Trim adjacent: trims selected event and adjacent

event simultaneously

Slip: move media within event without moving

the event

Copy event

Slide: move event without moving underlying

media

T

Shift+T

G

Shift+G

U

Ctrl+U

Ctrl+E

Ctrl+Shift+E

Keypad 4

Keypad 6

Alt+Keypad 4

Alt+Keypad 6

Ctrl+Keypad 4

Ctrl+Keypad 6

Keypad 8

Keypad 2

Ctrl+drag edge of event

Alt+drag edge of event

Ctrl+Alt+drag edge of event

Alt+drag inside the event

Ctrl+drag event

Ctrl+Alt+drag middle of event

SCREENBLAST MOVIE STUDIO SOFTWARE118

MovieStudio_ FINAL_EN.qxd  2/24/04  11:53 AM  Page 118



Reference Guide to Keyboard Shortcuts 

Mouse Wheel Shortcuts
Command Keyboard Shortcut

Zoom in/out on timeline

Scroll vertically

Scroll horizontally

Move the cursor one pixel left/right

Wheel Up/Down

Ctrl+Wheel

Shift+Wheel

Ctrl+Shift+Wheel

Timeline Commands
Command Keyboard Shortcut

Insert marker

Insert region

Insert command

Normal Edit tool

Next/Previous editing tool

Toggle snapping

Toggle snapping to frames

Toggle snapping to grid

Toggle snapping to markers

Toggle automatic crossfades

Toggle ripple editing

Change track focus

Insert/show/hide volume envelope

Remove volume envelope

Insert/show/hide pan envelope

Remove pan envelope

Pre-render video

Preview in external player

Rebuild audio peaks

M

R

C

Ctrl+D

D/Shift+D

F8

Alt+F8

Ctrl+F8

Shift+F8

X

Ctrl+L

Alt+Up/Down Arrow

V

Shift+V

P

Shift+P

Shift+M

Ctrl+Shift+M

F5
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Index

Index
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